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Introduction 

How to Use this Book 

Welcome to the RISAFloor User’s Guide. If you are a first-time user of RISAFloor, we recommend that 

you start with this book.  

Begin by reviewing First Look at RISAFloor on page 8 to familiarize yourself with the RISAFloor menus, 

toolbars, and shortcuts. Appendix A – RISAFloor Toolbar Button Quick Reference has also been 

included on page 213 to help you reference toolbar buttons. 

Following the introductory sections, notice that the book is divided into two parts: Part A and Part B, 

as described below. The two parts are independent, full tutorials, so you may go straight to the part 

that best suits your current design needs. 

Part A – Beam Supported Floors will guide you step-by-step through the RISAFloor modeling process to 

build and analyze a model using beam supported floors; Part B – Elevated Slab Design will guide you 

through building and analyzing a model with elevated slab floors in RISAFloor ES. In each part, you will 

create a real-world example of building and solving a model, making changes, and optimizing the 

model. Tips and shortcuts will also be demonstrated along the way.  

To complete all the tutorials will take only a few hours. However, you can speed up the process even 

further if you skip the supporting text and concentrate only on the action steps, which are indicated 

with diamond-shaped bullets, as shown below: 

 In order for you to achieve accurate results, it is important that you do not miss any of these 

action steps while performing the tutorials. 

The tutorials build upon themselves from start to finish. You have the option of performing them all at 

one time or performing each one separately. To make this possible, RISA provides model files for you 

to load at the beginning of each tutorial. These starter files are located in the RISA folder under 

Tutorials, and are named Tutorial A2 Starter.rfl, Tutorial A3 Starter.rfl, etc. 

After you have completed the tutorials in this guide, you can use the Help Menu and RISAFloor General 

Reference for complete, detailed information on every topic relating to RISAFloor. The topics are 

thoroughly indexed for quick reference.  

If you are a more experienced user and are not sure which book will be most helpful for your situation, 

consider that this User’s Guide covers how to apply RISAFloor features such as columns, beams and 

walls, but the specifics of how those elements are designed are covered in the Help Menu and the 

RISAFloor General Reference.  

Where to Download RISAFloor Book Updates 

Every effort has been made to ensure the accuracy of this book at the time of publication. The latest 

edition of all books and documents relating to this product are available in Adobe PDF format at 

http://www.risa.com. Click Downloads, Product Documentation, then RISAFloor. 
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Document Conventions 

The following conventions are used throughout this book: 

This convention: Indicates: 

CAPITAL LETTERS Names of keys on the keyboard – for example, SHIFT, CTRL, or ALT. 

KEY+KEY One key should be held down and then another key pressed – for 

example, CTRL+P or ALT+F4. 

Bold text 

Boxed text 

Bulleted text 

  

User interface options – for example, File menu. 

Notes or modeling tip information. 

Action item for building the tutorial model. 

Tutorial action item for building the model. 
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Using the Online Help 

Whether you need help on general topics, specific features, or toolbars, it is all built in to the extensive 

RISAFloor online Help system. The RISAFloor Help was designed to enable you to pinpoint the Help 

information you need quickly, by offering different ways for you to access and locate that Help, as 

described below: 

 

Help on  

general topics 
On the RISA toolbar, click the Help button . This is the fastest way to get help 

on general topics. You can also go to the main menu and click Help, then select 

Help Topics. 

Once you enter the Help, notice the three tabs on the left: Contents, Index, and 

Search. You can explore the Help by topic using either Contents or Index or 

explore the Help using your own specific keywords using Search. 

 

Help on a 

specific 

feature 

(context-

sensitive 

help) 

As you work, notice the Help buttons at the bottom of many of the dialog boxes. 

These provide direct access to the Help information related to the task you are 

performing.  

This context-sensitive help may be accessed by pressing the Help button on the 

dialog box or by pressing the F1 key. 

 

Help on 

toolbar 

buttons 

Are you uncertain what a toolbar button is for? Simply hold your mouse pointer 

over that button (without clicking), and a description of that button will be 

displayed.  
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Technical Support Information 

Technical support is an integral part of the software packages offered by RISA Tech, Inc. and is 

available to all registered licensees at no additional charge for the life of the program. The “life of the 

program” is defined as the time period for which that version of the program is the current version or 

until the program is discontinued. In other words, whenever a new version of RISAFloor is released, 

the life of the previous version is considered to be ended. Technical support is a limited resource; 

priority will always be given to those clients whose licenses are current first.  

RISA Tech, Inc. will only support the current version of RISAFloor. For a list of your support options, 

visit our website: www.risa.com/support. 

Before contacting technical support, you may want to take a few minutes to do the following: 

• Search the Help menu and all user documentation available for the product.  

• Search our Tips & Tricks database by visiting our website at http://www.risa.com. Click Learn, 

then Tips & Tricks, and then choose RISAFloor. 

When you are ready to make a support request, please be prepared to send us your model, and 

include the following information: 

• Your name, company name, and phone number. 

• Product name and serial number or Key ID. 

• A detailed problem description. 

• Your model (filename.rfl) as an e-mail attachment. If your model contains multiple members, 

or load combinations, please specify which ones we should look at.  

You can contact Technical Support by e-mail or phone, as follows: 

E-mail: support@risa.com 

E-mail is usually the best way to communicate with us when sending a model. Please include all the 

information listed above. 

Phone: (949) 951-5815 or (800) 332-RISA (7472) 

Technical support personnel are available from 6:00 A.M. to 5:00 P.M. Pacific Standard Time, Monday 

through Friday.  

RISA Online 

Visit RISA online at http://www.risa.com for:  

• Helpful Tips & Tricks 

• Downloads of user documentation and tutorials  

• Software updates – Any known problems are posted on the website, along with possible 

work-around procedures and/or service releases to update your software 

• Software verification problems 
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Before You Begin 

RISAFloor Overview 

RISAFloor has been developed to make the definition, design, and modification of building systems 

fast and easy. Analysis (including calculation of deflections and stresses) may be performed on simple 

single-story buildings or on larger multi-story structures. Plus, element design optimization is provided 

for columns, beams, and wall panels.  

Because of its unique ability to define the model and make revisions both graphically (using the 

drawing tools) and numerically (using the customized spreadsheets), RISAFloor is able to significantly 

speed up the design process. 

In RISAFloor, these two methods of entering and editing data work seamlessly together. Everything 

designed or drawn graphically is automatically recorded in the spreadsheets (which may be viewed 

and edited at any time)—and everything entered in the spreadsheets may be viewed and edited 

graphically at any time. The model can be rapidly edited, solved, viewed, modified, re-solved, etc. As 

you perform the step-by-step tutorials in this guide, you will be exploring both methods using the 

drawing tools and the spreadsheets. 

RISAFloor ES is an optional extension of RISAFloor which includes the added feature of elevated 

concrete slab floor design.  With this added feature, models can intermix elevated slab and beam 

supported floors.  Reinforcement design optimization is provided on slab floors for columns, beams, 

wall panels, and flat slabs. 

 

Hardware Requirements 

Operating System 

One of the following operating systems is required: 

• Microsoft Windows 11 (64 bit only) 

• Microsoft Windows 10 (64 bit only)  

• Microsoft Windows 8.1 (64 bit only)  

Note: RISAFloor ES is only available for 64-bit operating systems 

Hardware 

The following hardware is required: 

• 1 GHz or faster processor  

• 1024x768 or higher monitor resolution  

• 2 (or more) button mouse, mouse wheel recommended  

• 8 GB for 64 bit computers  

• 4 GB of hard disk space  
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Hardware Limitations 

• RISAFloor is not a multithreaded application, which means that it runs entirely within a single 

processor core. Therefore, the program does not take full advantage of multi-core or multi-

processor machines. This limitation affects how long it takes to solve a model.  

 

Program Limits 

Floors 200 

Walls (per Entire Model) 10,000 

Openings/Regions (per Wall Panel) 25/100 

Columns per Floor 2,500 

Beams per Floor 10,000 

Points per Floor 25,000 

Point Loads per Floor 10,000 

Line Loads per Floor 10,000 

Area Load Polygons per Floor 1,000 

Deck Polygons per Floor 1,000 

Materials 500 

Custom Wood Species 500 

Load Combinations 5,000 

Concrete Slabs per Floor (RISAFloor ES Only) 20 

Support Lines per Slab (RISAFloor ES Only) 300 

 

Demonstration Version:  You can open and solve a model of any size, however you may not: 

• Use this version for Professional Design Purposes 

• Create more than 2 Concrete Floor Slabs 

• Create a Concrete Floor Slab other than 8" thick, 3000 psi concrete 

• Save a model with more than 40 beams per floor 

• Save a model with more than 3 Floors 

• Save a model with more than 1 Concrete Floor Slab 

• Save a model with more than 20 columns or 4 walls 

• Save a model with more than 10 Support Lines 

• Import RISAConnection design results back into the RISAFloor demo. 

Also, the Demonstration Version will automatically shut down if left open for 24 continuous hours. 
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License Agreement 

For the full license agreement, please visit: risa.com/eula 

 

Installation 

Installation Instructions 

To install RISAFloor, please follow these instructions: 

• Contact the RISA licensing department (license@risa.com) for a program installation link. 

• Click on the link from the email that they will send you. 

• Follow the on-screen instructions. 

RISAFloor Customization–Important Assumption! 

Please ensure that when performing these tutorials, RISAFloor has not been customized in any way, 

and is in the default, installed state. If the installation of RISAFloor has been customized, you may reset 

the program defaults as follows: on the Tools menu, click Reset All Program Defaults.
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First Look at RISAFloor 

Starting RISAFloor 

This section describes the RISAFloor user interface, the toolbars, and shortcuts. We recommend that 

you review this section before you begin the tutorials. 

Start RISAFloor as follows: 

 On the Start button, click All Programs, select RISA, then select RISAFloor. 

Windows and Dialog Boxes 

 

 

 

 

 

 

Title bar Main menu  RISA toolbar    Minimize    Maximize    Close 

Status bar  Starting a Model dialog box         Workspace            Data Entry 

toolbar 
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Title bar The title bar at the top of your RISAFloor window can be very useful. Besides containing the 

name of the file that is currently open, it can also be used to move the window and 

minimize, maximize, and resize the window. 

To move the window, press and hold the title bar with your mouse, then drag to the 

desired location.  

Minimize, 

Maximize, 

Close 

The three buttons  on the right of the title bar control the RISAFloor window as 

follows: 

• Click Minimize  to minimize the window to a button on the taskbar. 

• Click Maximize  to maximize the window to full screen. Once it is full screen, 

click Restore Down  to restore the window down to its original size. 

• Click Close  to close the window. 

Workspace The actual work that you do in RISAFloor will be in the main area on the screen, the 

workspace. Currently the workspace is empty except for the Starting a New Model dialog 

box. As you create new model views and spreadsheets they will also appear in the 

workspace.  

Status bar The Status bar at the bottom of your screen will report information about your model as 

you work. 

 If the letter “S” is dimmed, a solution has not been performed. After a solution has been 

performed, the letter “S” will become blue in color with a red checkmark (as shown below). 

If the “S” is yellow, this means you have solution results but there have been modifications 

via the Member Redesign dialog box. 

To the right of the “S” are 3 status boxes: 

• The first status box displays general information relative to the task you are 

performing. 

• The second (middle) status box reports information about your deck or area load. 

• The third status box (on the far right) reports the cursor coordinates as you work 

in the model view. This will be demonstrated throughout the tutorial. 

Dialog 

boxes 

Dialog boxes are windows that help you perform a specific function within RISAFloor. For 

example, the Starting a Model dialog box is presented when you first open RISAFloor, 

which helps you find the file you wish to open.  
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Menus and Toolbars 

Main Menu 

 

The Main menu and its submenus provide access to all features RISAFloor has to offer, as summarized 

below: 

File Provides access to file operations such as opening, saving, and exporting files. 

Edit Provides editing tools that help you modify and manipulate the spreadsheets. 

You may use this menu to add or remove information from the spreadsheets or 

to sort and mathematically manipulate current spreadsheet data. 

Settings Allows you to open model settings. 

View Allows you to open a new model view or adjust the current model view. 

Insert Used to insert drawing columns, beams, walls, and loads into the model. All of 

these items may be drawn graphically or entered in the spreadsheets. This 

menu provides access to the graphical methods that RISAFloor provides, while 

the Spreadsheets menu gives you access to the spreadsheets. 

Modify Allows access to the graphic editing features and may be used to modify 

existing model elements. 

Spreadsheets Opens the spreadsheets. 

Solve Solves the model. 

Results Allows access to all analysis result spreadsheets. This button is dimmed when 

no results are available, such as before you run a solution. 

Tools Provides tools to help you organize, identify, and correct problems as you 

model the structure. Program Application Settings are also located here. 

Window  Manages all of the windows that you have open in RISAFloor, whether they are 

spreadsheets or model views.  

Help Provides access to the RISAFloor online Help menu. For more information on 

Help, see Using the Online Help on page 3. 

Director This feature allows you to integrate your model with RISA-3D and/or 

RISAConnection if you also own those products. 
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Toolbars 

The most commonly used features available on the Main menu are also available on the toolbars as 

toolbar buttons. The toolbars are designed to speed up your workflow by placing these tools close to 

your workspace and making them easily visible.  

Unlike some of the other toolbars, the RISA toolbar never changes. The other toolbars change, 

depending on whether you are in model (graphical) view or spreadsheet view. 

 

 

If you are not sure what a particular toolbar button does, simply position your mouse cursor over the 

button and a short definition will display. 

Note: You will discover many methods of accessing the tools available in RISAFloor. The methods you 

choose—whether menus, toolbars, or keyboard shortcuts—will simply be a matter of personal 

preference. 

Window toolbar  

(in Model View) – contains 

viewing commands 

Data Entry toolbar - 

provides quick access to 

spreadsheets (then toolbars 

switch to spreadsheet view) 

-AND/OR-  

Results toolbar - After the 

model is solved, the results 

are displayed here 

RISA toolbar – provides access to 

file operations, printing, changing 

design parameters, etc. 

Drawing toolbar - Toggle on with (CTRL+G) 

Selection 

toolbar – 

provides 

tools to 

help make 

selections 

Main 

In Model View 

Window toolbar – 

any time a 

spreadsheet is open, 

notice the window 

toolbar changes 

Selection toolbar – 

is not visible in 

spreadsheet view 

In Spreadsheet View 
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RISA Toolbar  

 

The RISA toolbar is located directly below the Main menu. Unlike some of the other toolbars, the RISA 

toolbar never changes. These buttons perform general actions such as opening and closing files, 

changing design parameters, printing, and solving the model.  

Window Toolbar  

…in Model View 

 

The Window toolbar is located directly below the RISA toolbar. When working in a graphic model view, 

the buttons provide model viewing tools, such as rotate and zoom, and others. 

…in Spreadsheet View 

 

When you are working in a spreadsheet, this toolbar provides spreadsheet editing tools, such as Sort, 

Block Fill and Block Math. 

Drawing Toolbar  

…on Beam Supported Floors 

 

…on Concrete Floor Slabs 

 

The Drawing toolbar provides tools to assist with creating and modifying your model graphically. This 

toolbar may be turned on and off (CTRL+G) as needed. 

Selection Toolbar  

…only visible in Model View 

The Selection toolbar is the vertical toolbar along the left side of the screen.  

It provides tools to help you select and unselect parts of the model.  

You will need to make selections when you do things like graphically edit a  

part of the model or print only part of the results.  
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Spreadsheet Toolbars  

(Data Entry and Results toolbars)  

These two toolbars provide access to the spreadsheets. You can turn 

them on and off on the RISA toolbar by clicking the Data Entry button 

 or the Results button . 

The Data Entry toolbar is a vertical toolbar on the right of your screen. It 

looks different than the other toolbars because its buttons consist of 

text instead of images.  

The Results toolbar is very similar. It appears after the model has been 

solved and provides quick access to the results spreadsheets. 

Both toolbars allow you to access the spreadsheets very quickly while 

building and solving your model. The buttons appear in the general 

order as you may need them.  

 

 

 

 

 

 

Note: The toolbars above include several slab-specific spreadsheets that are only available in 

RISAFloor ES.  For more information about these and how to use them, please see Part B: Elevated 

Slab Design on page 110. 
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Managing Windows, Model Views, and Spreadsheets 

Managing Windows 

As you work in RISAFloor, you will be working within model views and spreadsheets, each in their own 

window that may be moved around the workspace and resized as you wish. A powerful feature of 

RISAFloor is the ability to have multiple model views and spreadsheets open at one time. The Window 

menu provides many options to help manage the display of these windows. 

 

Managing Model Views 

You may open as many model view windows as you like. This is especially helpful when working 

zoomed in on large models. You might have one overall view and a few views zoomed in and rotated 

to where you are currently working. You may have different information plotted in each view. 

Remember that the toolbars displayed by RISAFloor vary depending on which window is active (the 

window with a colored title bar is the active window).  

For example, if your active window is a spreadsheet, and you are looking for the zoom toolbar, you will 

not be able to locate it until you click your model, switching to model view. Then you will be able to 

access the zooming tools, and all the other 

tools related to modeling. 

  

Scroll bar - to view information 

outside of the window’s viewing 

area, click the scroll arrows or drag 

the scroll bar to move the display 

one way or the other. 

Scroll  

arrows & 

scroll bar 

Minimize,  

Maximize, and  

Close buttons 
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Working in Spreadsheets 

Spreadsheets are composed of rows and columns of data cells. To add or edit data in a cell, click the 

cell, making it the active cell, then type. Only one cell can be active at a time, and it is denoted in 

green. You can change which cell is active using the LEFT ARROW, RIGHT ARROW, PAGE UP, PAGE 

DOWN, HOME keys, etc. 

You may also select blocks of cells to work on. To select a block of cells, click and hold the mouse 

button in the first cell in the block, drag to the last cell in the block, then release the mouse. To select 

an entire row or column, simply click the row or column label. To select multiple rows or columns, click 

and drag the mouse across multiple row or column buttons. 

 

 

 

  

 Column label – Click the 

column label to select 

the entire column 

Scroll bar 

Row of cells – Click 

the row label (at left) 

to select the entire 

row 

Column of cells 

Click any cell. 

Notice the status 

bar displays an 

explanation of the 

current column. 
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Part A: Beam Supported Floors 
This first part of this book (Part A) will focus on building beam supported floors within RISAFloor. With 

the guidance of the following seven tutorials, you will build, solve, and modify a typical building 

comprised of several different types of members and materials.  

The tutorials build upon themselves from start to finish. You have the option of performing them all at 

one time or performing each one separately. To make this possible, RISA provides model files for you 

to load at the beginning of each tutorial. These starter files are located in the RISA program folder 

under Tutorials, and are named Tutorial A2 starter.rfl, Tutorial A3 starter.rfl, etc. 

When you finish all seven tutorials, the final product will look like this: 

 

 

 

To complete all seven tutorials will take only a few hours. However, you can speed up the process 

even further if you skip the supporting text and concentrate only on the action steps, which are 

indicated with diamond-shaped bullets, as shown below: 

 In order for you to achieve accurate results, it is important that you do not miss any of these 

action steps while performing the tutorials. 
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Part A: Tutorial 1 – Columns and Walls 
Overview 

This first tutorial will introduce the various drawing features that RISAFloor has to offer. You will model 

a Project Grid, a Slab, several Footings and Grade Beams, and explore the Model Settings of the model.   

Starting a New File 

When you are ready to begin, start RISAFloor if you have not already done so: 

 On your desktop home screen, double click on the RISAFloor icon . 

 

Note: The view shown above is from the Demonstration version of RISAFloor. If you are running the 

full version of the program, this dialog will look slightly different. 

  



Part A: Tutorial 2 – Modeling Beams 

18 

 

To create a new model, begin by creating a floor plan, or click Close and work on your own. 

 Click Create a New Floor Plan   to begin. 

Since this is the first floor in the model, the only option is Original Floor.  After creating one or more 

floors, you may then use them as the starting point for additional floors, either by creating a Copy or a 

Child of an existing floor. 

The Create New Floor Plan dialog box also allows you to set the Elevation, the Default Area Load, and 

the Default Deck for the floor. These settings are discussed in more detail on page 58. 

 In the Elevation box, enter 15 ft. 

 

 Click Ok. 

A new, blank floor will display, along with an empty Project Grid spreadsheet. 
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Project Grid 

You can generate grids or type them in one at a time. To create grids: 

 Under the Rectangular Grid Parameters in the Z Axis Increments box, type 

30,15,44,30,30,25,10,20,10.  

Since the grid spacing is the same for the Z Axis and the X Axis grid, copy and paste the Z Axis 

Increments into the box for the X Axis Increments.  

 

Next, let’s look at the labeling for the grids. 

For Z Direction/Radial Line Labeling: 

 In the Start Label box, type 1. 

For the Label Order, click A to Z. 

For X Direction/Radial Line Labeling: 

 In the Start Label box, type J. 

For the Label Order, click Z to A. 

  



Part A: Tutorial 2 – Modeling Beams 

20 

 

The Project Grid Lines dialog box should look similar to below: 

 

 Click Apply. Then click OK to close the dialog box. 
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You can verify the values in the Project Grid Lines spreadsheet and modify the grid lines if needed. 

 When complete, your Project Grid Lines spreadsheet should look similar to the image below: 

 

Note: Pasting is not available in the Demonstration version, so you must re-type these values if you are 

using the Demonstration version. 

 Click Redraw  (on the Window toolbar) to get a better view. Your workspace should like 

this: 
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Model Settings 

Model Settings are settings that apply to the entire model. To view these settings: 

 On the RISA toolbar, click the Model Settings button . 

 On the Description tab, type in your Company and Designer name.  

 

 Click on the Solution tab. 

 

The entries under this tab are used to control settings that affect the general solution of the full 

model.  For more information on any of these entries, click on the Help button to open the Help File. 
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 Click on the Codes tab. Make sure the inputs match the image below: 

 

The entries under this tab present the available design codes to control the design of each material, 

live load reduction, and vibrations.  For more information on any of these entries, click on the Help 

button to open the Help File. 

 Click on the remaining tabs to review the settings for Composite design, Wind and Seismic 

loads, and Concrete design parameters. 

When finished, close the Model Settings dialog box: 

 Click OK. 

Defining your Model 

When building your model, you will define the elements in the order that they will be built. For 

example, supporting elements (columns & walls) must be in place first before you can define elements 

that use those supports (beams). You may enter model elements through the spreadsheets or with the 

drawing tools. The use of drawing tools will be the focus of the next few sections of this tutorial.  

The Drawing toolbar is located at the top of the workspace and looks like this:  

 

 To turn the Drawing toolbar on or off, go to the Window toolbar, and click the Graphic Editing 

button . 

The toolbar buttons are arranged in the order you would 

use them to define your model (left to right). 
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Columns 

When creating columns, you may choose the material and shape of the column, as well as designate 

its orientation. You may orient the column towards a specific point, give it a specific angle, or combine 

the two. For this model, we will use several of these options. 

 On the Drawing toolbar, click Draw or Modify Columns  to view the Draw Columns dialog 

box. 

Define the W14 gravity columns, as shown below. 

 Under Material, select A992. 

 Under Shape Group, select WF14.  

 

 Click Apply to start drawing the columns.  

Note: When you enter the drawing mode, your cursor changes to .  
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You can now start defining the columns by clicking or drawing, as shown below: 

 Enter columns by clicking on the F5, B2, and I9 grid locations. 

 Next, enter multiple columns by drawing a box around the grid intersections between D1 and 

E4, as shown in the diagram below. 

 

 Repeat for the grid intersections between G6 and J7. 

 

To further define the gravity columns: 

 On the Drawing toolbar, click Modify Drawing Grid  to create a local drawing grid. 

 Under Drawing Grid Origin, in the Z Axis and the X Axis boxes, type 119.  

 Click Radial Grid Parameters.  In the Angle Increments box type 24@15, and in the Radial 

Increments box type 30,35. 
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The dialog box should look like this: 

 

 Click Apply to close the dialog box. 

Now use the newly created radial drawing grid to define the gravity columns. 

 Create the gravity columns by clicking the radial grid points shown in the image below. 

Note:  If you have trouble clicking on the exact location, enlarge the model using the  

wheel button on your mouse to zoom in and out.  
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Next, add the lateral columns: 

 On the Drawing toolbar, click Draw or Modify Columns . 

 Under Function, click Lateral, and then click Apply. 

 Add lateral columns at C5, E5, F1, F2, F6, F8, I5, and J5. 

Note: Lateral columns are displayed in red; gravity columns are displayed in blue. 

 When you finish adding these columns, use the right mouse button (right-click) or ESC to 

terminate the column drawing tool. 

Click the grid points to 

place the columns 

shown. 

 

Hint: 

Zoom in and out using 

the wheel button on 

your mouse. 
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Notice that by default all the columns are oriented with their webs parallel to the vertical axis.  To 

change the orientation of the columns toward the center column: 

 On the Window toolbar, click the Joint Labels button  two times to turn on the labels of 

the point locations. 

 Make note of the point label at the center of the radial grid. That point label will be used 

below to orient the columns in your radial grid. 

 On the Drawing toolbar, click Draw or Modify Columns  again and select the Modify 

Properties tab. 

 In the Orientation Options area, select the Use? check box (once it is selected, it will display in 

red). In the Orient to Point box, enter the point label for the center of your grid (this is the 

point label you made note of above).  

 

 Click Apply Entries by Clicking/Boxing Columns Individually, and then click Apply. 

Note: The cursor will change to . 
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Now, you can select the columns as follows: 

 Click on or draw a box around the columns in the upper right portion of the radial grid, as 

shown in the figure below. Note that the orientation of these columns changes toward the 

center column. 

 

 

 Continue clicking or drawing boxes around the remaining columns in the lower lefthand 

portions of the radial grid, so that all columns should now be oriented toward the center 

column.  

Note: Use care not to select the center column, as it already has the correct orientation.  

When you are finished with the radial columns, you can now turn the labels and the drawing grid off. 

 On the Window toolbar, click the Joint Labels button  to turn off the labels. 

 On the Drawing toolbar, click the Drawing Grid button  to turn off the Drawing Grid. 
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Next, rotate the horizontal columns 90 degrees, so that they are oriented properly: 

 On the Drawing toolbar, click Draw or Modify Columns  again. Ensure that the Modify 

Properties tab is still selected. 

 In the Orientation Options area, click the Use? check box (once it is selected, it will display in 

red). In the Orient to Point box, clear the point label and leave it blank. In the Rotate Angle 

box, enter 90.  

 

 Click Apply. 

Note: The cursor will once again change to . 



  Part A: Tutorial 2 – Modeling Beams 

31 

 

 Click on or draw a box around the columns circled in the next image.  

When you are done, your columns should have rotated 90 degrees, and oriented as shown below. 
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Wall Panels 

Prepare to draw your wall panels: 

 On the Drawing toolbar, click Draw or Modify Walls . 

 Under Material, select Concrete. 

 Under Function, click Lateral. The wall panel settings should match those in the image below.  

 

 Click Apply. 

Note: Your cursor will change to . 
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Start drawing your wall panels, as follows: 

 Draw in a wall panel between A3 and A5. To do this, click on A3, move the mouse to A5 and 

click again. 

Note: After you draw a wall, your cursor is “anchored” to the end point of the wall. To release the 

drawing tool, use your right mouse (right-click) or ESC. 

 Draw the remaining wall panels between F3 and F4, G5 and H5, and F10 and H10. 

 When you finish adding the walls, use the right mouse button (right-click) or ESC to terminate 

the wall panel drawing tool. 

If you make a mistake or if you want to delete a wall, click CTRL+Z to undo, or delete the wall as 

follows: on the Modify menu, click Delete, then click Delete Based on This Criteria and check the 

Delete Selected Walls check box. 

Next, you will add an opening to the wall panel on gridline A. 

 Double-click on the wall panel between A3 and A5 to open the Wall Panel Editor. 

 

This Editor allows you to add openings and design regions to the wall panels.  You also can edit the 

Material, Design Rule, and Thickness in this view. 
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Wall Panel Openings 

You will add in an opening next.  Before you do this, turn off the rendered view of the wall. 

 Click the Toggle Rendered View button  at the top center of the Editor Drawing toolbar. 

Now only the drawing grid is visible in the plane of the wall. 

 

Next, set up a Drawing Grid to help define the opening. 

 Under Horizontal Grid Increments, enter 23,3,3,20. 

 Under Vertical Grid Increments, enter 7,5. 

 Click into the Editor model space to update the grid. 

 

Now draw in the opening. 

 Click on the Create New Openings button  (in the upper left corner of the Editor). 

Note: Your cursor will change to  . 
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Use the coordinate information in the lower right Wall Panel Editor to help select the door opening 

coordinates. 

 First click on the top left of the door opening (23,7). The coordinates in the Wall Panel Editor 

are based on the drawing grid in the Wall Panel Editor and do not match the Model 

Coordinates or Status Bar.  

 

Note: Any existing region will need to be deleted before drawing the opening. 

 Next click the lower right corner of the door opening (26,0). 

When complete, the door opening will show with the X line and lintel label. 

 

Continue to draw in the large door opening. 

 Click on (29,12) and then on (49,0). 

 Right-click or click ESC to cancel the opening drawing tool. 
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Wall Panel Design Regions 

When finished, you can add in the design regions around the openings. The Wall Panel Editor allows 

you to create design regions in two ways: manually draw in each region, or use the automated 

generation tool.  You will use the automated generation for this model. 

 Click on the Generate Wall Regions Automatically button  (in the upper left corner of the 

Editor). 

Turn the rendered view back on for a better view. 

 Click the Toggle Rendered View button  at the top center of the Editor Drawing toolbar. 

Now you can see the two openings, and five regions that were generated around the openings. 

 

For more details on how to model wall panels, including information on masonry design and wood 

design, refer to https://risa.com/documentation. 

 Click OK to close the Wall Panel Editor. 

Your model should look similar to the following image: 

 



  Part A: Tutorial 2 – Modeling Beams 

37 

 

This is the end of Tutorial A1.  

You may save your model to be used as the starting point for the next tutorial, or begin the next 

tutorial using the .rfl starter file in the RISAFloor Tutorials folder. To save the model: 

 On the File menu, click Save As and enter a file name. 
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Part A: Tutorial 2 – Modeling Beams 
This tutorial will guide you through drawing individual beams and explore the different time-saving 

options for adding infill beams. This tutorial continues from where the previous tutorial ended, so 

follow these steps to get your model up and running: 

If you are continuing from the previous tutorial: 

 From the Window menu, select Single View. 

 On the Window toolbar, click the Graphic Editing button to activate the Drawing toolbar. 

 On the Data Entry toolbar, click Close  to close it.  Skip ahead to the next page. 

-OR- If you are starting here from scratch, follow the steps below to load the starter file provided by 

RISA: 

 Double-click on the RISAFloor icon to start the program.  

 Click Open Model . Double-click the Tutorials folder, select Tutorial A2 Starter.rfl and click 

Open. Click Close (or Cancel) to exit the Model Settings dialog box.  

 On the Window toolbar, click the Graphic Editing button to activate the Drawing toolbar. 

Your screen should now look like this: 
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Primary Framing 

 On the Drawing toolbar, click Draw Beams  to open the Draw Beams dialog box. 

 

In this dialog box, materials and shapes may be chosen along with orientation options. You may also 

assign the beams to a set of design rules. You may draw single span members or continuous beams. 

For this model, we will select a wide flange, hot rolled steel member drawn point to point. 

 Under Material, select A992. 

 Under Shape Group, select Wide Flange. 

 Under Design Rules, select Typical.  

 Click Apply. 

Note: The cursor will change to to signify that you are now in drawing mode. 
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 Draw a box around the entire model, as shown in the figure below:  

 

Notice that some beams were not automatically drawn in, such as those supported by wall panels or 

other beams. These members can be drawn individually, without going back to the dialog box. 

 Draw in the 14 beams circled below by clicking from point to point. Start by clicking A3, then 

D3. Use the right mouse button (right-click) or press ESC to release the mouse between 

beams. Then click B2 and B3. Continue clicking to draw the remaining beams.  

 

The beams in the radial portion of the structure may also be drawn from point to point. 
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 Continue clicking from point to point to draw in the beams shown below.   

 

 On the Drawing toolbar, click Modify Drawing Grid . 

 Click the Snap To Options tab.  

 Under Universal Snap Increments, make sure the Z Axis and X Axis Increments are both set to 

1 ft.  Check the Use Universal Increments check box (this will allow you to draw freehand 

without being limited to a project or drawing grid). 

 

 Click Ok to return to the model view. 

Hints: 

Use the wheel button on your 

mouse to zoom in and out. 

If you terminate the drawing 

beams tool before you are 

finished, you may recall it by 

clicking CTRL+D. 
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 Now, draw in two beams beginning at (54, 119) and (119, 54), as shown circled in the image 

below. To help you locate the coordinates, use the Status bar at the bottom of your screen (on 

the right).  

 

Continue drawing the beams until your model looks like this: 

 

Next, change the function of the beams that span between the lateral columns to make them lateral 

elements.  

 On the Drawing toolbar, click Draw Beams  and select the Modify Properties tab.  

 In the Function area, select the Use? checkbox (once it is selected, it will display in red). Under 

Function, click Lateral.  

 

 Click Apply Entries by Clicking Beams Individually, and then click Apply. 
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 Now, click on the four beams that are shown circled in the image below (you can click 

anywhere on the beams). 

Note: The color for these beams will change from blue to red because you are changing their function. 

Your model should now look like this: 

 

Lastly, turn off the Universal Snap Points. 

 On the Drawing toolbar, click Modify Drawing Grid . 

 Click the Snap To Options tab.  

 Uncheck the Use Universal Increments checkbox, then click Ok to go back to the model view. 
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Infill Framing 

RISAFloor’s Infill Framing tool assists your design process by quickly generating beams within existing 

bays. This tool will help you quickly create all of your secondary members:  

 On the Drawing toolbar, click Generate Beams .  

 Under Material, select A992. 

 Under Beam Orientation, click Vertical. 

 

 Click Apply. 
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 Click once inside each open bay to fill in (as shown in the image below) until the upper left side 

of model looks like this: 

 

If you zoom out to view a larger portion of your model, you can generate secondary beams in multiple 

bays at once.  

 On the Drawing toolbar, click Generate Beams  again. 

 Under Beam Orientation, click Horizontal, and then click Apply. 

 Draw a box around the area between grid lines F5 and J10 to select the entire area. 

  

Notice that one bay 

was purposely left 

empty.  This will be 

used later in the 

tutorial. 
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When finished, your model should look similar to the one shown below: 

 

You can also use this tool to generate infill beams that are parallel to an adjacent member. 

 On the Drawing toolbar, click Generate Beams . 

 Under Beam Orientation, click Angle to a Beam, then enter an angle of 0. 

 Click Apply. 

 First click on the bay you want to fill in and then click on the member that the new beams 

should be parallel to, as shown in the diagrams below. 

 

 Continue with other bays until the radial portion of your model is similar to that shown below: 

First Click Second Click 
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 Terminate the drawing tool using the right mouse button (right-click) or press ESC. 
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Additional Beam Drawing Tips (optional) 

Before moving on, we recommend exploring some of the other beam modeling tools provided in 

RISAFloor. The steps in the remainder of this tutorial are optional, but you may find them very helpful 

to master. 

The first tool will demonstrate how to add ten members by simply clicking on two end points. 

 On the Drawing toolbar, click the Draw Beams  button again. 

 Click the Draw Beams tab, make sure that the Keep spans continuous (as drawn) check box is 

NOT checked, then click Apply. 

 

 Click at the start of the first beam (C2) and then again at the end (C5). Right-click to release the 

mouse. 

Your model should now look like the image below. The single span beams will be automatically broken 

at the supports for you.  
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 Since these members should not be a part of your completed model, click the Undo  

button to undo the creation of the beams. 

Note: When drawing new members, you may create either single or continuous span members. If the 

Keep spans continuous check box had been selected, RISAFloor would have created a continuous 

beam that spanned from C2 to C5. 

Another useful tool is the ability to offset beams from the end of another parallel beam:  

 On the Drawing toolbar, click the Draw Beams button  to again open the Draw Beams 

dialog box. 

 Under Drawing Options, click Draw Beam to Beam. In both the 1st Offset and 2nd Offset boxes, 

enter 5 ft, and then click Apply. 
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 Experiment with this tool by clicking to create members parallel to the diagonal beam 

between D4 and C5, as shown in the image below. 

 

These offsets are automatically taken from the end of the beam that is closest to where you clicked.  

 Click the Undo  button to undo the creation of the beams. 

Lastly, we’ll explore the quarter and third snap points on members, which can be a very powerful tool. 

 On the Drawing toolbar, click the Modify Drawing Grid button  and select the Snap To 

Options tab. 

 Under Beam/Wall Snap Locations, make sure that the Quarter Points and Third Points check 

boxes are checked. 

 Under Universal Snap Increments, make sure that the Use Universal Increments check box is 

cleared. 

 Click Ok. 

This allows you to draw to the quarter or third points of any beam or wall as a drawing point in your 

model. Use this tool to add the diagonal beams.  

 On the Drawing toolbar, click the Draw Beams button  again to open the Draw Beams 

dialog box. 

 Under Drawing Options, select Draw Point to Point, and click Apply. 

 Draw by clicking in the member from the quarter point of one beam, and dragging to the half 

point of another. Right-click to release the mouse. 

Note: The cursor provides additional information regarding the cursor coordinates. As you move your 

cursor around on your screen, a box adjacent to your cursor will appear and populate with the 

coordinates of the cursor. 
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The mouse coordinates that are displayed are the coordinates of the grid point or joint that is nearest 

to the cursor. These are the same coordinates displayed in the Status Bar in the third box when a 

model view is active. 

Note: The Status Bar (in the lower right hand corner of the screen) reports not only the coordinates of 

your cursor, but also the half, third, and quarter point locations. 

 

This tool eliminates the need to manually manipulate your Project or Drawing Grids.  

 

 Click the Undo  button several times to undo the creation of the beams. 

 

 

This is the end of Tutorial A2. 

You may save your model to be used as the starting point for the next tutorial, or begin the next 

tutorial using the .rfl starter file in the RISAFloor Tutorials folder. To save the model: 

 On the File menu, click Save As and enter a file name. 

Note:  If you are running the Demonstration version, the file is now too large to save.  You will need to 

directly continue on with the remaining tutorials or use the Starter Files for the following tutorials. 
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Part A: Tutorial 3 – Decks & Diaphragms 
This tutorial will guide you through adding a diaphragm edge, editing deck properties, and drawing in 

deck loads.  

If you are continuing from the previous tutorial: 

 From the Window menu, select Single View. 

 On the Window toolbar, click the Graphic Editing button to activate the Drawing toolbar. 

 On the Data Entry toolbar, click Close  to close it.  Skip ahead to the next page. 

-OR- If you are starting here from scratch, follow the steps below to load the starter file provided by 

RISA: 

 Double-click on the RISAFloor icon to start the program.  

 Click Open Model . Double-click the Tutorials folder, select Tutorial A3 Starter.rfl and click 

Open. Click Close (or Cancel) to exit the Model Settings dialog box.  

 On the Window toolbar, click the Graphic Editing button to activate the Drawing toolbar. 

Your screen should now look like this: 

 

Creating Diaphragm Edges 

RISAFloor provides tools to create or manipulate your diaphragm edges. To select the entire model 

and create a new diaphragm edge: 

 On the Selection toolbar, click the Select All button  to make sure the entire model is 

selected.  
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 On the Drawing toolbar, click the Create Diaphragm Perimeters button  to open the 

following dialog box.  

 

Since the entire model is selected, your new diaphragm edge will encompass all the defined beams 

and walls.  

 Click Create a DIAPHRAGM Edge.  

 Click Apply to automatically create edges using the default settings. 

Also, when defining diaphragm edges, you may box the elements or draw the edges yourself. This 

feature can help you select opening areas in your diaphragm. 

 On the Drawing toolbar, click the Create Diaphragm Perimeters button  to open the dialog 

box again. 

 Select Create an OPENING perimeter. When creating openings, you will primarily use the first 

option to click within the bays for the opening. The second option may be used when there are 

members that frame through the opening.  

Hint: 

When creating diaphragm 

edges, you can also use the 

selection tools to unselect 

any elements that you do 

not want inside the 

diaphragm edge. 
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 Select Click Within or Box the Beam/Wall perimeter for the OPENING.  

 Select the Keep this dialog open after Apply is pressed check box. 

 Click Apply. 

The Create Diaphragm Edge and Opening Perimeters dialog box should remain open.  

Note: If the dialog box is covering any portion of your model, you can move it by clicking on the title 

bar and dragging it out of the way. 

 Click in the bay, as shown below. 
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 Go back to the dialog box and select Draw a Polygon Around the Beams/Walls for the 

OPENING, then click Apply. 

 Draw a polygon around the opening, as shown image below. When your polygon is complete, 

double-click to close it off. 

 

 When finished, use the right mouse button (right-click) or press ESC to terminate the drawing 

tool. 

 Click Close to exit the Create Diaphragm Edge and Opening Perimeters dialog box. 

You have now created your diaphragm edge. The next step is to review and/or modify the deck 

properties that are assigned to it.  
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Deck Properties 

To specify the properties of the deck, it is important to understand a little about how the deck 

spreadsheet works: 

 On the Main menu, click Spreadsheets, select Deck Properties. 

 

 For the Concrete Deck, change Max Span to 12 ft. 

 Next, click within the Material Type cell of the second row (Composite Deck).  Click on the red 

arrow to open the Deck Selection dialog.   

 

 

 Click through the various Deck Types to see the available options.  Click Cancel when you are 

finished. 

 Next, click the Loads tab and review the loading input options. 

The self-weight of the deck and the construction dead and construction live loads may all be specified 

in the Loads tab.  

Note: The loads in the Loads tab of the Deck spreadsheet are different from the area loads defined in 

the Area Loads spreadsheet because these loads are specifically linked to the type of deck 

construction. 

 Close the spreadsheet by clicking Close . 
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Next, you will learn how to apply these deck properties to your floor. 

Each floor has a Default Deck and Deck Angle that will be used for the entire floor if no other deck is 

defined. To review and modify these defaults: 

 On the Main menu, select Spreadsheet and click Floors. 

 Under Area Load Default, select Office. 

 

 Next, click the Beam Floors tab. 

 Under Deck Default, select Composite Deck. 

 Under Deck Angle Default, enter 0. 

 

Unless you specifically assign a new area load or deck to a region of the floor, these default properties 

will be assumed to be applied over the whole floor (within the diaphragm edge). 

Since your model has some areas where the default slab and orientation will be different, assign a new 

deck angle to these areas:  

 Click Close  to exit the spreadsheet and return to the model view. 

 On the Drawing toolbar, select the Assign Diaphragm Edge and Deck Properties button . 

 In the Deck Type box, select Composite Deck. 

 Under Deck Direction, click Parallel to X Axis. 

 Select Box the Deck Area Perimeter. 

 

 Click Apply.  
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 Draw a box around the area between F5 and J10 as shown in the following image: 

 

 Press CTRL+D to reopen the Deck Assignment dialog box. 

 In the Deck Type box, select Concrete Deck. 

 Under Deck Direction, click Angle from Z Axis, and enter an angle of 45 degrees. 

 Click Apply. 
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 Assign this data to the two radial portions of your model by boxing them as shown in the 

image below. 

 

Note: 

The color of the hatch 

identifies what type of deck is 

assigned and the direction of 

the hatching coincides with 

the general span direction of 

the deck.  This hatching will 

show angles at intervals of 45 

degrees, the closest multiple 

will be used. 

This is a good visual 

confirmation of the decks that 

you have applied to your 

floor.  In the area where no 

local deck is applied, the 

default deck will be used.  In 

areas where more than one 

local deck is applied, the top 

deck (the last one drawn) will 

be used. 
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When you are finished drawing in your deck, your screen should look like the image shown below. 

 

RISAFloor gives you two ways to plot the deck graphically. The first is to plot the deck properties as 

they are defined. The second is to view them as they are resolved by the solver and applied to the 

members. We are going to view the deck as applied: 

 On the Main menu, click View, select Model Display Options. 

 Select the Points/Decks/Diaphragms tab. 

 Make sure the Show Deck Assignments check box is selected, and select As Applied. 

 

 Click OK. 
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Your display should change to look like the following image:  

 

Notice the differences between this plot and the previous plot. In this plot, you can verify the location 

of openings.  
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 Move your mouse over the various decks. Notice the deck type and orientation information 

are displayed in the Status bar as you move the cursor.   

 

Note: If your mouse cursor is still shown as the deck drawing cursor, use the right mouse (right-click) 

or ESC to terminate this drawing tool. 

Since the next section deals with area loads, you can turn off the deck display: 

 On the Main menu, click View, select Model Display Options. 

 Select the Points/Decks/Diaphragms tab. 

 Clear the Show Deck Assignments check box, and then click OK to close the dialog box. 

This is the end of Tutorial A3. 

You may save your model to be used as the starting point for the next tutorial, or begin the next 

tutorial using the .rfl starter file in the RISAFloor Tutorials folder. To save the model: 

 On the File menu, click Save As and enter a file name. 

Note:  If you are running the Demonstration version, the file is now too large to save.  You will need to 

directly continue on with the remaining tutorials or use the Starter Files for the following tutorials. 
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Part A: Tutorial 4 – Loading 
This tutorial will guide you through editing and adding the various types of loads available in RISAFloor. 

If you are continuing from the previous tutorial: 

 From the Window menu, select Single View. 

 On the Window toolbar, click the Graphic Editing button  to activate the Drawing toolbar. 

 On the Data Entry toolbar, click Close  to close it.  Skip ahead to the next page. 

-OR- If you are starting here from scratch, follow the steps below to load the starter file provided by 

RISA: 

 Double-click on the RISAFloor icon to start the program.  

 Click Open Model . Double-click the Tutorials folder, select Tutorial A4 Starter.rfl and click 

Open. Click Close (or Cancel) to exit the Model Settings dialog box.  

 On the Window toolbar, click the Graphic Editing button to activate the Drawing toolbar. 

Your screen should now look like this: 

 

  



  Part A: Tutorial 4 – Loading 

65 

 

Area Loads 

Area load magnitudes are defined in a spreadsheet and then applied to the floor as polygons, much 

like the deck properties in the previous section. Area loads that are within the diaphragm edges (but 

not inside an opening) are automatically attributed in the deck direction to the beams and walls and 

then reduced for member design according to the live load reduction methods chosen in Model 

Settings. 

Edit the Area Loads spreadsheet, as shown below: 

 On the Main menu, click Spreadsheets, select Loads, and then select Area Load Definitions. 

 Edit the load information to match what is shown in the image below: 

 

The entries in the Area Loads spreadsheet are described below: 

Label The name you will later use to refer to the load when you apply or view it. 

Additive If this is checked, the load applied will add to the load that is drawn beneath it 

in the order of how they were drawn in the model. 

PreDL 

PostDL 

LL 

LL Type 

These entries allow you to specify load magnitudes for different categories that 

will later be used in the load combinations that you solve.  

 PreDL and PostDL are for dead loads that are pre- and post-composite. 

Remember that other dead loads (deck self-weight and construction 

dead load) were already defined within the deck definitions 

spreadsheet.  

 LL and LL Type load columns are for the live load magnitude and the 

type of live load which you may choose from a list. 

VL 

 

Specifies the vibration load. The vibration load (along with the self-weight of 

the beam and deck) will be used for calculating the mass for a vibration check, 

per AISC Design Guide #11.  

Dyn Load The dynamic load will be used to determine the diaphragm mass and mass 

moment of inertia for a RISA-3D seismic analysis. 

Each floor has a default area load that will be used within the entire floor slab if no other load is 

specified. You can review this information as follows: on the Main menu, click Spreadsheet, then 

select Floors. The Area Load Default is set to Office. To use different loads in an area, you can 

graphically define local area loads.  

 Click Close  to exit the spreadsheets and return to the model view.   
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To apply local area loads:  

 On the Drawing toolbar, click the Draw Area Loads button  to display the following dialog 

box: 

 

Draw the area loads: 

 Under Uniform Area Loads, in the Area Load box, select Storage, then select the Point to Point 

Draw of the Area drawing option. 

 Click Apply.  

Note: The cursor will change to . 

These two options allow you to apply 

the load automatically by clicking or 

drawing a polygon around the 

members which define the area. 

-OR- 

This option allows you to draw the 

polygon manually by clicking on 

points. 

Notice you also have the option of 

drawing in a tapered load.  This can 

be useful for modeling certain types 

of snow loads, but will not be used in 

this tutorial.  For more information on 

tapered area loads please refer to the 

RISAFloor General Reference. 
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 Draw the polygons for the two area loads by clicking on points, as shown in the following 

figure. Double click on the last point to finish drawing the polygon. 

Tip: When you are in drawing mode, you can automatically snap to the quarter and third points of any 

beam (as demonstrated in the previous tutorial). 

 

 Press CTRL+D to reopen the Create Area Loads dialog box. 

 Under Uniform Area Loads, in the Area Load box, select Public, then select the Point to Point 

Draw of the Area drawing option. 

 Click Apply. 

Coordinates of this point: 

(187.33, 89) (1/3rd Pt) 

Coordinates of this point: 

(89, 187.33) (1/3rd Pt) 
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 Draw in the public area loads, shown in the next image. 

When you are finished drawing area loads, your screen should look like the image shown below. 

 

Note: Loads do not have to start or end on project grid lines. In areas where more than one load is 

applied, the top load (the last one drawn) will be used by RISAFloor. The exception to this is that any 

additive load will be applied along with the load beneath it.  

 Press CTRL+D to reopen the Create Area Loads dialog box. 

 Under Uniform Area Loads, in the Area Load box, select Add Piping. 

 Click Apply. 

The blank areas where you have 

not drawn in a load will receive 

the default Office load 

automatically.  

Area Load edges 

are at the quarter 

point locations. 
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 Draw in a piping load that overlaps the other loads, as shown in the image below, by clicking 

on points. 

 

 Press ESC to cancel the drawing tool and return to your regular cursor. 

RISAFloor gives you two ways to plot the area loads. The first is to view them as they were input. The 

second is to view them as they are resolved and applied by RISAFloor. You are going to view them as 

applied. 

To plot the area loads:  

 On the Main menu, click View, select Model Display Options.  

 Select the Loads tab. 

 Make sure the Uniform Area Loads check box is selected, click As Applied, and then click 

Apply. 

 In the Show Loads for Category box, select DL PostComp. Click OK to exit.  

This load is bounded either by 

the quarter point of the beam 

or by the project grid points. 

Since the piping was specified 

as additive, this new load will 

be automatically combined 

with the other existing loads. 

Coordinate location: 

(167.75, 0) 
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Your screen should look similar to the figure shown below: 

 

Notice that the default Office load was applied automatically, and that no area load is applied to the 

two slab openings. Also, note that the additive piping load was automatically combined with the 

Office, Public, and Storage loads that it crossed.  

On the Window Toolbar, you can use these three controls to manipulate the display of your loads:  

 

Turn off the display of the area loads, as follows: 

 On the Main menu, click View, select Model Display Options. 

 Click the Loads tab, and then click to clear the Uniform Area Loads check box. 

 Click OK.  

Toggle the graphical 

display of the loads. 

Select the various load 

categories or combinations. 

Toggle between load categories 

and combinations. 
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Line Loads 

You can use line loads to model the weight of cladding, partitions, architectural components, etc. 

Prepare to draw in line loads as follows: 

 On the Drawing toolbar, select the Line Loads button . 

 Enter the information as it appears in the following figure:  

 

 Click Apply. 

Note: The cursor will change to . 
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To see the model better while you are drawing in the load, change to an isometric view and zoom in: 

 On the Window toolbar, click on the Isometric button . 

 Click the Zoom buttons to zoom in on the right-hand portion of the floor as shown in the next 

image.  

 Draw in the load by clicking on the two points, as shown in the image below. When finished, 

right-click to release the mouse. 

 

When you are finished, notice that you have specified a tapered line load to represent a non-structural 

partition. The line load spans diagonally across the deck. This is important because it will actually 

result in parabolic loading of the supporting beams.  

To return to a planar view and continue: 

 Use the right mouse button (right-click) or press ESC to exit the drawing mode. 

 On the Window toolbar, click the Plan button . 

 On the Window toolbar, click Redraw  to return to a full view. 

Next, the loads due to the exterior cladding need to be modeled. To do this, apply a uniform load of 

2.5 kips/ft to all beams on the perimeter of the building. RISAFloor provides a selection tool that 

makes this easy.  
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First, unselect your entire model and make the following selection changes: 

 On the Selection toolbar, click UnSelect All  to unselect your entire model. 

 Also on the Selection toolbar, click on the Selection Criteria button . The Select Items for 

Current View dialog box will open. 

 Click the Beams tab and select the Perimeter Beams Only check box.  

 Under Selection Options, click Select Beams.  

 

 Click OK to apply the selection. 

Notice that only the exterior beams of the building are selected. Also notice that you have selected 

two beams that only run along the perimeter for a portion of their length. You must apply your 

cladding to these beams separately.  
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 Unselect each of the beams circled below by clicking on them. 

 

 On the Drawing toolbar, select the Line Load button  again to open the Floor Line Loads 

dialog box. 

 For the DL Post load, enter a starting and ending magnitude of 2.5 kip/ft. 

 Under What happens when Apply is pressed?, click Apply to All Selected Members/Walls. 

 Click Apply. 

Your structure should look like this: 
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Now, add the last two cladding loads.  

 Press CTRL+D to re-open the Floor Line Loads dialog box. 

 Click Apply Load by Drawing Point to Point. 

 Click Apply. 

 Draw in the line loads between A3 and B3 by clicking each point. Use your right mouse button 

(right-click) or press ESC to release your mouse after drawing each load. 

 Draw in the line loads between H9 and H10 by clicking each point. 
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Point Loads 

Prepare to apply point loads: 

 On the Selection toolbar, click Select All  to select the model. 

 On the Drawing toolbar, click Assign point loads . 

 Enter the information show below:  

 

 Click Apply. 

Since some of your loads are located in the middle of a deck span, it will be helpful to turn on the 

universal drawing snap points and zoom in on your model:  

 On the Drawing toolbar, click the Modify Drawing Grid button .  

 Click on the Snap To Options tab. 

 Select the Use Universal Increments checkbox and click Ok. 
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Draw in the point loads: 

 Zoom in significantly on the left side portion of the floor using the mouse roller, as shown 

below. 

 Use the coordinates (notice they are displayed in the Status bar) and the snap points to draw 

in a point load at each of the following coordinates: 

(0,149) 

(5,143)  

(5,155)  

(25,143)  

(25,155) 

(30, 149)  

When you are finished, your screen should look like this: 

 

Note: Point loads that are applied inside the deck edges may be applied anywhere on the deck and will 

be attributed automatically to the beams, walls, and columns. However, if they are applied outside of 

deck edges or within deck openings, they must be applied directly on beams, walls or columns.  

This is the end of Tutorial 4. 

You may save your model to be used as the starting point for the next tutorial, or begin the next 

tutorial using the .rfl starter file in the RISAFloor Tutorials folder. To save the model: 

On the File menu, click Save As and enter a file name. 

Note:  If you are running the Demonstration version, the file is now too large to save.  You will need to 

directly continue on with the remaining tutorials or use the Starter Files for the following tutorials. 
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Part A: Tutorial 5 – Solution & Results 
This tutorial will guide you through generating load combinations, running a solution, design 

optimization, and reviewing the results. 

If you are continuing from the previous tutorial: 

 From the Window menu, select Single View. 

 On the Window toolbar, click the Graphic Editing button to activate the Drawing toolbar. 

 On the Data Entry toolbar, click Close  to close it.  Skip ahead to the next page. 

-OR- If you are starting here from scratch, follow the steps below to load the starter file provided by 

RISA: 

 Double-click on the RISAFloor icon to start the program.  

 Click Open Model . Double-click the Tutorials folder, select Tutorial A5 Starter.rfl and click 

Open. Click Close (or Cancel) to exit the Model Settings dialog box.  

 On the Window toolbar, click the Graphic Editing button to activate the Drawing toolbar. 

Your screen should now look like this: 
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RISAFloor solves load combinations that are defined in the Load Combinations spreadsheet. As 

RISAFloor designs members, it chooses members that satisfy the codes specified in the Model Settings 

and the rules that are defined in the Design Rules spreadsheet.  

Load Combinations 

To view the load combinations: 

 On the Main menu, click Spreadsheets, select Load Combinations.  

 

On the Combinations tab, you will combine and factor the various loads that you have already applied 

to your model.  

 Press the F4 key four times to delete all of the default load combinations. 

Now that you have a spreadsheet open, notice the Window toolbar looks different. 

 On the Window toolbar, click the LC Generator button . The Load Combination 

Generator dialog box will be used to generate the load combinations needed to design the 

model. 

For this tutorial, assume that in the regions where this project will be built, the governing roof loads 

are usually roof live load, rather than snow or rain.  

 In the LC Region list, select United States.  

 In the LC Code list, select 2015 IBC ASD. 

 Click to clear the SL and RL check boxes so that you will not be generating more load 

combinations than are needed. 

 

 Click Generate. 
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The following load combinations will be generated by RISAFloor:  

 

Notice there are really two sets (categories) of load combinations. The first two (Load Combinations 1 

and 2, above) use pre-composite loads only. The other five (Load Combinations 3-7) combine the total 

dead load with the various live loads that may be applied to your model.  

Next, you will generate LRFD load combinations for your concrete wall panel design. 

 Click the LC Generator button .  

 In the LC Code list, select 2015 IBC Strength. 

 

 Click Generate. 
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This finalizes your load combinations as shown below:  

 

Next, you will mark which load combinations to use for each material. 

 Click the Design tab to review the remaining information associated with these generated load 

combinations. 

 

This spreadsheet allows you to determine which load combinations shall apply to each material type.  

You also have the ability to enter the ASIF (Allowable Stress Increase Factor for the AISC 9th Edition Hot 

Rolled Steel Code) and the CD (Load Duration Factor) for NDS wood design.   

Since you have generated both strength and service load combinations, you will need to use the 

material checkboxes to designate which combinations apply to the Hot Rolled Steel members and 

which apply to the Concrete walls. 

 Uncheck the Hot Rolled Steel checkboxes for the strength level combinations (lines 8-14). 

 Uncheck the Concrete checkboxes for the service level combinations (lines 1-7). 
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When finished, your spreadsheet should look like this:

 

 Close the spreadsheet by clicking the Close button . 

Solving and Reviewing Results 

Note: Results produced by your model may not exactly match the results shown in this tutorial. This 

may be caused by a variety of factors, including how the model was created and which version of the 

program is being used.  

Now that you have applied your loads and generated your load combinations, you can solve for 

results.  To solve the model: 

 On the Main menu, click Solve – Design Members/Walls/Slabs. 

 When the solution finishes, we are presented with the following dialog: 

 

This Warning is common in RISAFloor.  When the model is solved, it is common for the original 

“required” size of a column to be insufficient at the end of the solution when the other members 

(beams and walls) have been optimized and re-sized.   

 Click RESOLVE to replace the upper columns and resolve with the larger sizes.  
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When the solution is finished, the chosen member sizes are displayed on the plot (or, if you are in 

rendered mode, the model is rendered with the sizes) and the solution Warning Log is displayed.  

 

Note: The purpose of the Warning Log is to inform you whenever a modeling issue or error arises 

which affects the design of the floor. For example, the first entry is informing you that you have 

exceeded the maximum deck span, including the actual coordinates where the deck span violation 

occurred. This will be helpful later when optimizing your design.  

For now, open the Design Results spreadsheet:  

 On the Main menu, click Results and select Designs. 

 

The Design Results spreadsheet summarizes all members across all material types (each material type 

is contained in tabs at the top). The Hot Rolled tab lists a summary of the member design complete 

with the number of studs, camber, and end reactions. Similar information would be found under the 

Cold Formed , Wood, or Concrete tabs if any such members were contained in this structure. Similarly, 

design information for Steel and Wood Joists, if used in the model, would be found under the Steel 

Products or Wood Products tabs. 
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You may open the other spreadsheets to review the other types of results. 

 On the Main menu, click Results, select Code Checks, Shear, Bending, etc. 

The Code Check spreadsheet gives you a quick overview of the checks for bending, deflection, and 

shear. There are also individual results spreadsheets that give detailed information for the Bending, 

Deflection, Shear, and Vibration checks. The Reactions spreadsheet gives the member end reactions 

for the governing load categories.  

Return to your model view to explore the graphic result viewing options: 

 Close any open spreadsheets. 

 On the Main menu, click View, and select Model Display Options. 

 Click the Beam/Columns/Walls tab. Under Line Draw, in the Color Basis list, select Defl Limit.  

 Under Show Beams (the check box should already be selected), in the Labeling list, select No 

Labeling.  

 

 Click Apply.  
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Your plot should now look like this:  

 

This image gives a quick graphical representation of the adequacy of each beam for the deflection 

limits specified in the Design Rules spreadsheet. You can create a similar plot to display the Bending or 

Shear Checks. You can also plot the Vibration Frequencies and Accelerations to check your entire floor 

system for the AISC Vibration criteria.  

 Click Cancel to exit the dialog box and return to your model view. 

 Click the Box Zoom button  and select the portion of the model where the most obvious 

deck span violation occurred, as shown in the figure below: 

 

 On the Selection toolbar (left side), click the Detail button . 

Note: Your cursor will change to . 
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 Click any one of the members that surround the gap in your framing (shown boxed in the 

previous image). This will display the member detail report for that member.  

 Click on a few other members and review the detail reports for those members. 

 

The detail report displays loading information, and shear, moment, and deflection diagrams. It also 

gives design data, composite member properties, and the calculated allowable stresses. Since the 

model had a triangular dead load that was angled to the deck, it produced a parabolic load on the 

beam M18 (shown above). RISAFloor can accurately approximate this load pattern by modeling a 

series of partial length trapezoidal loads. 

This type of loading is common whenever you have partial length area loads, or tapered line loads that 

do not run orthogonal to the deck span or beam framing. Since it can result in significant increases in a 

member’s maximum moment and end reactions, it is important to provide an accurate representation 

of this load.  

 Click Close  to return to the model view before proceeding to the next section. 

This detail report is 

shown for Dead Load 

results.  To change 

categories, use the list at 

the upper left. 

Use the LC/Cat button to 

switch between load 

categories and load 

combinations. 

Use the arrow buttons to 

view the next or 

previous member. 



  Part A: Tutorial 5 – Solution & Results 

87 

 

Modifying the Model 

Now that you have reviewed all the data, it is time to make some changes to your model. Modifying 

the model may be done graphically or within the spreadsheets. Although this tutorial will concentrate 

on the graphical methods, remember that you may view and edit most data from within the 

spreadsheets also. 

To perform an interactive redesign on any member: 

 On the Selection toolbar, click the Design button , and then click on any member. 

This will open the Member Redesign dialog box, as shown below. You can scroll through the available 

shapes and see how the bending, shear, and deflection are affected. To modify the selected beam, 

simply click OK. This interactive redesign is powerful because you are free to manipulate your model 

without erasing all of your design results. Keep in mind that when you are finished with all of your 

modifications, be sure to re-run your analysis to recalculate changes in self weight and relative floor 

stiffness.  

 

 Click Cancel to close the dialog box. 

You can now make a framing change to your model.  

 On the Window toolbar, click the Graphic Editing button  to activate the Drawing toolbar if 

it is not already visible. 

 On the Drawing toolbar, click Draw Beams . 

This is the same button that you initially used to draw the beams.  
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When you click on this button, a warning box will appear informing you that continuing with the 

operation will clear your design results.  

 

 Since you are finished browsing the results, select Yes to continue. 

 Click the Draw Beams tab. Under Function click Gravity, and then click Apply. 

 Draw in the member, as shown circled below, by clicking on the two end points.  

Right-click to release the mouse. 

 

Before you end, check the spreadsheet warning log: 

 On the Main menu, click Spreadsheets, select Warning Log. 

Notice that even though you have cleared your results, RISAFloor maintains the Warning Log to assist 

you when modifying your model.  

This is the end of Tutorial 5.  

You may save your model to be used as the starting point for the next tutorial, or begin the next 

tutorial using the .rfl starter file in the RISAFloor Tutorials folder. To save the model: 

On the File menu, click Save As and enter a file name. 

Note:  If you are running the Demonstration version, the file is now too large to save.  You will need to 

continue directly with the remaining tutorials or use the Starter Files for the following tutorials. 
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Part A: Tutorial 6 – RISA-3D Integration 
This tutorial is intended to introduce you to the features of RISA-3D that directly relate to its 

interaction with RISAFloor. For more detailed information on RISA-3D, refer to the RISA-3D User’s 

Guide and RISA-3D General Reference.  

If you are continuing from the previous tutorial: 

 From the Window menu, select Single View. 

 On the Window toolbar, click the Graphic Editing button to activate the Drawing toolbar. 

 On the Data Entry toolbar, click Close  to close it.  Skip ahead to below. 

-OR- If you are starting here from scratch, follow the steps below to load the starter file provided by 

RISA: 

 Double-click on the RISAFloor icon to start the program.  

 Click Open Model . Double-click the Tutorials folder, select Tutorial A6 Starter.rfl and click 

Open. Click Close (or Cancel) to exit the Model Settings dialog box.  

 On the Window toolbar, click the Graphic Editing button to activate the Drawing toolbar. 

Your model will look like the following: 
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To see the interaction between RISAFloor and RISA-3D, solve your RISAFloor model, and then use 

RISA-3D to analyze and design your lateral system.  

 On the RISA toolbar, solve the model by clicking Solve . 

 Click OK from the Solution Warning dialog. 

 On the Main menu, click the Director button (top right) and select RISA-3D. 
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RISA-3D Lateral Load Generators 

After you select RISA-3D, you will be prompted for information on the wind and seismic loads of your 

structure.  

First, the Wind Loads dialog box will display. 

 Make sure your parameters match those in the image below: 

 

Review the information shown in the Wind Loads dialog box. In the future, if you make any changes in 

the Wind Load Parameters area, be sure to click Calc Loads to recalculate. 

Be sure to also check the information generated in the Wind Load Results area. This is a summary of 

the wind loads that have been calculated for you.  

 Click OK to accept the loads. 
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After the Wind Loads dialog box closes, the Seismic Loads dialog box will display. 

 Make sure your parameters match those in the image below: 

 

Review the information shown in the Seismic Loads dialog box. In the future, if you make any changes 

in the Seismic Load Parameters area, be sure to click Calc Loads to recalculate. 

Be sure to also check the information generated in the Seismic Load Results area. This gives the 

equivalent static force distribution and base shear that have been calculated for you.  

 Click OK to accept the loads. 

 If the Model Settings dialog box displays, close it by clicking OK or Cancel. 
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RISA-3D will now open and display an isometric view of your model. You are now working completely 

in RISA-3D. The interface of RISA-3D is different from RISAFloor, but menus and buttons work the 

same way. 

Before doing any graphical editing, turn off the display of the load: 

 On the Window toolbar, click the Show Joint Labels button   to turn off the display of the 

Joint Labels. 

Your screen should now look like this: 
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 On the Data Entry toolbar (at right), select Basic Load Cases. You can now review the load 

data that was generated. 

As you review the data in this spreadsheet, notice that all your basic load cases have been created for 

you, including wind and seismic load cases for each direction.  

  

 When you are finished reviewing the data, click Close  to close the spreadsheet and return 

to your model view. 

Diaphragms are also created in RISA-3D based on your RISAFloor geometry: 

 On the Data Entry toolbar (at right), click Diaphragms. 

 

Notice that the diaphragms already contain the diaphragm mass and mass moment of inertia 

information that you would need for a dynamic analysis. In this spreadsheet, you can specify the 

percent of width you want RISA-3D to use to account for the accidental eccentricity in the X or Z 

directions. 

 Click Close  to exit the Diaphragms spreadsheet and return to the model view. 
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 On the Window toolbar, click on the Diaphragm Display button  (it may already be 

displayed). 

This will display the RISAFloor diaphragms which have been automatically created for you.  

Notice that only the beams, columns, and wall panels that were specified as LATERAL members were 

generated in your RISA-3D model. You can always add vertical braces, modify your wall panels, or 

manipulate your model as you wish.  

 

Next, add some X bracing, as follows: 

 On the Home menu, click the Draw Members button . Notice that the Properties Panel 

(at left) changes. 
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 Select VBrace for Member Type, Hot Rolled Steel for Material Type, A500 Gr. B Rect. for 

Material, and SquareTube for Design List. 

 Select Shape Database for Section/Shape. Click the ellipsis button  next to Shape. 

 Select Assign Shape Directly. Click the ellipsis button  under Start Shape. 

 Make sure you are on the Hot Rolled tab. Under Shape Type, select Tube and under Shape 

Name, type HSS4x4x4. 

 Click OK twice to close both dialogs. 

 Click the ellipsis button  next to I Release. Select Pinned (Torsion Fixed) for both I End 

Release Codes and J End Release Codes. Click OK. 
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 Draw in the X braces (as shown in the image below) by clicking the nodes on each end of each 

member. Right-click to release the mouse when needed. 
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RISA-3D Load Combinations 

Next, add the common load combinations used for this type of model, including all the code required 

eccentric loadings for wind and seismic loads. This will demonstrate how the program automatically 

generates these load combinations; saving you the time and energy normally spent entering them 

manually.  

 On the Data Entry toolbar, click on Load Combinations to open the Load Combinations 

spreadsheet. 

Although you previously generated load combinations for your RISAFloor model, you will now 

generate your lateral load combinations for use in the RISA-3D model. 

 Click the LC Generator button within the spreadsheet to display the following dialog. 

 

 On the first (Gravity) tab, in the LC Region list, select United States. 

 On the first (Gravity) tab, in the LC Code list, select 2015 IBC ASD. 

 Uncheck RLL (Roof Live Load), SL (Snow Load), and RL (Rain Load). 

 Uncheck Generate Deflection LCs 

 Click Generate. 
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 Click on the Wind tab. 

 Under Wind Load Options, click X and Z w/Ecc (make sure the Reversible check box is 

cleared). 

 

 Click Generate. 

 Click on the Seismic tab. 

 Under Seismic Load Options, click X and Z w/Ecc (make sure the Reversible check box is 

cleared). 

 

 Click Generate.  Then click Close to close the dialog. 
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This will generate the load combinations shown below.  

 

Why so many load combinations? Each code load combination that includes an earthquake or wind 

load becomes six load combinations when you include all the possible eccentric cases (if you had 

selected the Reversible option, this would have expanded to 12 cases). 

The LC Generator feature allows complete control over whether or not to include these more detailed 

load combinations. Load combinations or categories that are not relevant to your region can be 

completely eliminated by modifying the provided .xml spreadsheets.  

For example, if you are in a year-round sunny climate like south Florida, do you really need to check 

your structure for all the combinations that include snow load? Therefore, to remove the snow loads 

from your generated load combinations, locate and modify the spreadsheet. The United States 

spreadsheet is located in C:\users\Documents\RISA\Load Combinations (or C:\RISA\risa_LC_lists) and 

is named United States.xml.  

Note: Before editing this file, you may want to copy the original in case you want to restore all the 

settings back to the default.  

Resize the 

window by 

clicking and 

dragging 

downward on 

the bottom 

right corner. 
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As you can see from this tutorial, the interaction between RISAFloor and RISA-3D is completely 

seamless. However, this tutorial is only an introduction to the many features of RISA-3D. We 

recommend downloading the RISA-3D User’s Guide for tutorials demonstrating the features of this 

powerful program, including solution and reviewing results. 

Another option is that you can run your model in RISA-3D to resize your beams and columns. Then, 

return to RISAFloor to see how all those changes have been incorporated in the RISAFloor model for 

gravity load analysis.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

This is the end of Tutorial 6. 

You may save your model if you choose, but it is not necessary for the next tutorial. If you choose to 

save your model: 

 On the File menu, click Save As and enter a file name. 

Note: You will notice that this file saves as a RISAFloor (.rfl) model, even though we have now been 

working in RISA-3D. This is because the file contains RISAFloor data that would be lost if the RISA-3D 

file were detached. To reopen the file in the future, you will need to open it in RISAFloor, solve, and 

use the Director tool to bring it back into RISA-3D. 
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Part A: Tutorial 7 – RISA Interoperability 
RISAFloor has several options for importing or exporting projects to and from other industry software. 

This tutorial will introduce you to several of those options.  

Note: This tutorial requires that you save your results in order to export them into other programs.  

Unfortunately it is not possible to save results with the Demonstration version of RISAFloor.  However, 

if you would like to learn more about the export/import options, please see our website for a 

collection of detailed instructional videos and blogs which include tips and tricks for these features. 

RISA-Revit Link:  http://www.risatech.com/partners/prt_revit.html?tab=3  

CIS/2 Translator: http://www.risatech.com/p_cis2.html?tab=2  

DXF Export/Import: http://risanews.com/tag/dxf/  

RISA-Revit Link 

Because the RISA-Revit Link is a bi-directional exchange link, new models can be created in either 

RISAFloor or Revit and edited in either program.  

Start by exploring the export options from RISAFloor to Revit. If you do not have the RISA-Revit Link, 

you may download it at no cost from our website. Here are instructions on how to install the link: 

 Click Close  to exit RISAFloor if you have the program open. 

 Go to http://www.risa.com/partners/prt_revit.html, click Downloads, and then select the 

RISA-Revit Link version you want to download. 

 Download and install the link. 

Follow the steps below to load the RISAFloor starter file for this tutorial: 

 Double-click on the RISAFloor icon to start the program.  

 Click Open Model . Double-click the Tutorials folder, select Tutorial A7 Starter.rfl and click 

Open. Click Close  (or Cancel) to exit the Model Settings dialog box.  

Solve the model and save: 

 Click Solve  to solve the model. Click OK from the Solution Warning dialog. 

 From the File menu, click Save and be sure to Save Results. 
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Your model should now display design data such as member sizes, end forces, and number of studs: 

 

 There is no need to export anything.  You simply need the RISAFloor input file (.rfl). 

 Close RISAFloor by selecting Exit from the File menu on the Main menu. 

You can now open Revit Structure and import this exchange file: 

 Open a new file in Revit Structure. 

 On the Main menu, Save the file as TutorialA7.rvt as the file name. 

Note: This tutorial is based on the RISA interface with Revit Structure 2017. Please see our website for 

more information: http://www.risa.com/partners/prt_revit.html.  

 Open a 3D Analytical view. 

 On the Main menu, click Add-Ins, and select Import from RISA. 
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 Click Browse to locate the Autodesk Revit (.exc) exchange file, as shown below. 

 

 

Once in Revit, you can modify your model and then export back to RISAFloor. Because of its two-way 

functionality, you can modify the model in either program and the other will recognize the updates.  

Note: This was just a basic description of the RISA-Revit Link interoperability. For more information, 

you may download documentation from the RISA website specific to the Link and how to use it. 

Go to the RISA website: http://www.risa.com/partners/prt_revit.html. 
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CIS/2 Translator 

The RISA CIS/2 Translator is a tool for transferring data from RISA to the CIM steel part 21 file format. 

There are two basic modes for the CIS/2 Translator: export and import. Currently RISAFloor only 

exports data using the export mode. You may download this translator at no cost from the RISA 

website.  

Here are instructions on how to install the translator: 

 Click Close to exit RISAFloor if it is open. 

 Go to http://www.risa.com/products.html, click RISA CIS/2 Translator to download the 

Translator.  

 Install the Translator. 

To open the RISA CIS/2 Translator: 

 From the Start Menu, select All Programs, click RISA, and then click RISA CIS2 Translator. A 

dialog box will display. 

 Select RISAFloor under Products.  Then browse to select the Input file. 

 

 Click RUN.  

 The output .stp file is now available to import into your steel detailing software. 

Note: This was a very basic description of the CIS/2 Translator. For more detailed information on the 

translator and how to use it, please see the RISA CIS/2 Translator General Reference, available for 

download from the RISA website: https://www.risa.com/documentation. 

  

Click this button 

to Browse for 

your Input file. 
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RISAFloor & CAD 

RISAFloor offers a DXF import/export feature that provides two-way compatibility with any other 

program that can read and write DXF files--this includes most major CAD programs and many analysis 

programs. With this feature, RISAFloor is able to produce CAD-quality drawings that list your beam 

sizes, camber, stud layout, end reactions, etc.  

Follow the steps below to load the RISAFloor starter file for this portion of the tutorial: 

 Double-click on the RISAFloor icon to start the program.  

 Click Open Model . Double-click the Tutorials folder, select Tutorial A7 Starter.rfl and click 

Open. Click Close  (or Cancel) to exit the Model Settings dialog box.  

Solve the model and save: 

 Click Solve  to solve the model.  

 On the File menu, click Save As and enter a new file name.  

Your model should now display design data such as member sizes, end forces, and number of studs. 

 

 On the Main menu, click File, click Export, and select DXF File. 

 Enter the file name Tutorial and click Save. The Export DXF File dialog box will display. 
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 Enter the information shown below and click OK. 

 

You should be able to open this DXF file with any standard drafting package. The following is an 

example of the information that can be written to the drawing file.  
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Similarly, you can import a DXF file into RISAFloor for analysis.  

 On the RISA toolbar, click on New Model  to start a fresh model. 

 Because you want to import geometry rather than start from scratch, click Close to exit the 

Starting a Model dialog box. 

 On the Main menu, click File, click Import, then select DXF File. 

 Select the tutorial file you recently exported and saved. It should be named Tutorial 

A7_FLOOR_1.dxf.  

The Import DXF File dialog box will open. 

 Enter the information shown below: 

 

 Click OK. Your model will import and open a new floor from the imported DXF file. 

 

This is the end of Tutorial 7. 
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Conclusion 

This completes Part A: Beam Supported Floors.  

Congratulations on completing your introductory tour of RISAFloor! The time you invested in 

performing these tutorials is time well spent. We are confident that the knowledge gained by taking 

the time to step through these tutorials will increase your productivity and allow you to complete 

future projects more quickly and efficiently. 

If you have any questions or comments, please contact us by phone at (800) 332-7472 or email at 

info@risa.com. 
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Part B: Elevated Slab Design 
This second part of this book (Part B) will focus on building a model with elevated slab floors in 

RISAFloor ES. With the guidance of the following five tutorials, you will build, solve, and modify a 

typical building comprised of elevated concrete slabs, columns, and wall panels.  

Note:  In order to complete this model, you will be required to use RISAFloor ES.  For more information 

on this new product and to find the demonstration version download, please see our website: 

www.risa.com.  

The tutorials build upon themselves from start to finish. You have the option of performing them all at 

one time or performing each one separately. To make this possible, RISA provides model files for you 

to load at the beginning of each tutorial. These starter files are located in the RISA program folder 

under Tutorials, and are named Tutorial B2 starter.rfl, Tutorial B3 starter.rfl, etc. 

When you finish all five tutorials, the final product will look like this: 
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To complete all five tutorials will take only a few hours. However, you can speed up the process even 

further if you skip the supporting text and concentrate only on the action steps, which are indicated 

with diamond-shaped bullets, as shown below: 

 In order for you to achieve accurate results, it is important that you do not miss any of these 

action steps while performing the tutorials. 
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Part B: Tutorial 1 – Columns & Walls 
Overview 

This first tutorial will introduce the various drawing features that RISAFloor ES has to offer. You will 

model several columns and walls and explore the Model Settings.  Please note that in order to 

complete this model, you will be required to have RISAFloor ES installed.  For more information on this 

new product and to find the demonstration version download, please see our website: www.risa.com.  

Starting a New File  

When you are ready to begin, start RISAFloor ES if you have not already done so: 

 On your desktop home screen, double click on the RISAFloor icon.   

 

Note: The view shown above is from the Demonstration version of RISAFloor ES.  If you are running 

the full version of the program, this dialog will look slightly different.  
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To create a new model, you may begin by creating a floor plan, open an existing file, or click Close and 

work on your own.  With this tutorial we will create a new floor plan. 

 Click the Create a New Floor Plan button . 

The Create New Floor Plan dialog box allows you to input your Floor Type as well as some general 

floor options.  Since this is the first floor in the model, the only Floor Creation Option is Original Floor. 

After creating one or more floors, you may then use them as the starting point for additional floors, 

either by creating a Copy or a Child of an existing floor. 

We will create a concrete elevated slab floor. 

 Under Floor Type, select the Concrete Floor Slab. 

 In the Elevation box, enter 15 ft. 

 

  Click Ok and a new blank floor will display. 
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Drawing Grid 

RISAFloor ES offers both Project Grids and Drawing Grids.  In our model we will use the DXF Import 

option to import in our Drawing Grid background.   

Note: Please see the RISAFloor General Reference Manual to learn more about the difference between 

Project Grids and Drawing Grids. 

The DXF Drawing Grids dialog should have automatically opened for you.  If not, select Drawing Grids 

from the Modify menu then click on the Import DXF tab. 

  

 Click on the Browse for File button and then browse to the Tutorials file under your 

Documents\RISA\Model Files\Tutorials folder. 

 Select the file called Tutorial B1 Drawing Grid.dxf. 
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Next you are given the option to select which layers in your DXF drawing to import.  For this tutorial 

we will bring in all layers. 

 Select the Use All Layers option and then click Done. 

  

This will bring in the DXF drawing as a background drawing grid for us to use for drawing snap points. 

 



Part B: Tutorial 1 – Columns & Walls 

116 

 

Model Settings 

Model Settings are settings that apply to the entire model. To view these settings: 

 On the RISA toolbar, click the Model Settings button . 

 Click on each tab to review the settings (the default settings will be used for this tutorial, so 

there is no need to change any of this data). 

 

Close the Model Settings dialog box: 

 Click Cancel. 

Drawing 

When building your model, you will define the elements in the order that they will be built. For 

example, supporting elements (columns & walls) will be drawn in before the slab edge. You may enter 

model elements through the spreadsheets or with the drawing tools. The use of drawing tools will be 

the focus of the next few sections of this tutorial.  

The Drawing Toolbar is located at the top of the workspace and looks like this:  

 

 To turn the Drawing toolbar on or off, go to the Window toolbar, and click the Graphic Editing 

button . 

In the Model 

Settings dialog box, 

you can enter 

model information 

and member design 

information. 

The toolbar buttons are arranged in the order you would 

use them to define your model (left to right). 



  Part B: Tutorial 1 – Columns & Walls 

117 

 

Columns 

When creating columns, you may choose the material and shape of the column, as well as designate 

its orientation. You may orient the column towards a specific point, give it a specific angle, or combine 

the two. For this model, we will use several of these options. 

 On the Drawing toolbar, click Draw or Modify Columns  to view the Draw Columns dialog 

box. 

Before drawing, let’s set up a Design Rule to govern the optimization (design) of the columns. 

 Click on the Add button next to the Design Rules drop down menu. 

  



Part B: Tutorial 1 – Columns & Walls 

118 

 

Column Design Rules 

Create the design rule: 

 Type in a Design Rule Label of “Tutorial Column”. 

 Type in a Max Width and Depth of 22”. 

 

 Click onto the Rebar tab. 

 Select Optimize Rebar and set the Max Vert Bars to a #9 bar. 

 

 Click OK to close the dialog and save your design rule. 

Note: Design rules can be edited from the design rules spreadsheets. 
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Return to the Draw Concrete Columns dialog to finish defining the columns: 

 Under Concrete Column Shape, select the Rectangular Shape Group. 

 Under Concrete Column Options, select the Conc4000NW material.  

 Make sure that your new Design Rule is still selected. 

  

 Click Apply to start drawing the columns.  

Note: When you enter the drawing mode, your cursor changes to .  
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You can now start defining the columns by clicking on the drawing grid locations as shown below: 

 Create a column at the top left corner by clicking on the column grid location. 

 

You can also define columns by “box selecting” a group of drawing grid points.   

 Hold down the left mouse button and drag the cursor to select the box over your column grid 

locations. 

 

 Use whichever method you prefer to select the remaining column grid locations. 
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 Right-click your mouse to cancel the drawing tool when done. 

When finished, your model will look like this: 
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Modifying Your Columns 

RISAFloor ES provides a quick and easy way to view and edit properties of any existing item in the 

model.  You may do this through the input spreadsheets or using any of the Modify dialogs.  For 

column stacks, you can also double-click the column in the model view and open the Column Stack 

Manager. 

Column Stack Editor 

 Double-click on any column in the model view.  This will open the following dialog: 

 

From this dialog you have the ability to edit the column properties.  Simply make your changes and 

then click the “Use?” checkbox before clicking Apply. 

For this tutorial, rather than change each column one by one through their editors, we will use the 

Modify dialog to change their Function. 

 Close the Column Stack Manager without making any changes by clicking Cancel. 
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Modifying Columns 

 Select Columns from the Modify menu. 

 Under Function, select Lateral.  Check the “Use?” checkbox. 

 At the bottom, select Apply Entries to All Selected Columns and then click Apply. 

 



Part B: Tutorial 1 – Columns & Walls 

124 

 

All of the columns will change to red, indicating that they are now all lateral members. 
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Wall Panels 

Prepare to draw your wall panels: 

 On the Drawing toolbar, click Draw or Modify Walls . 

 Set the Material to Concrete and change the Material Set to Conc4000NW. 

 Under Function, click Lateral. The wall panel settings should match those in the image below.  

 

 Click Apply. 

Note: Your cursor will change to  to indicate that you are now ready to draw wall panels. 
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First zoom in on the area of the elevator opening using the Box Zoom tool. 

 Click on Box Zoom   from the Drawing toolbar. 

 Box select the elevator opening on the drawing grid. 
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Now that you have a zoomed in view, start drawing your wall panels: 

 Draw in the wall panels by first clicking on the outside lower left point of the elevator opening.  

Then click on the outside drawing grid corner directly above that.   

 

 Continue around the outside of the elevator opening. 

 

After you draw a wall, your cursor is “anchored” to the end point of the wall.  

 

 To release the drawing tool, use your right mouse (right-click) or ESC. 

 Return to the full model view by clicking on the Full Model View button  from the Drawing 

toolbar. 
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When finished, your model should look like the following. 

 

 

If you make a mistake or if you want to delete a wall, click CTRL+Z to undo, or delete the wall as 

follows: on the Modify menu, click Delete, then click Delete Based on This Criteria and check the 

Delete Selected Walls check box. 
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Modifying Wall Panels 

Next, you will add in a wall panel opening, design region and continuous boundary condition. 

 Double-click on the middle wall that is parallel to the global Z axis. 

 

This will open the Wall Panel Editor dialog. 

 

This Editor allows you to add openings and design regions  to the wall panels.  You also can edit the 

Material, Design Rule, and Thickness in this view. 
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Wall Panel Openings 

You will add in an opening next.  Before you do this, turn off the rendered view of the wall. 

 Click the Toggle Rendered View button  at the top center of the Editor Drawing toolbar. 

Now only the drawing grid is visible in the plane of the wall. 

 

Next, set up a Drawing Grid to help define the opening. 

 Under Horizontal Grid Increments, enter 4,6,4. 

 Under Vertical Grid Increments, enter 8,3. 

 Click into the Editor model space to update the grid. 

 

 

Now draw in the opening. 

 Click on the Create New Openings button  (in the upper left corner of the Editor). 

Note: Your cursor will change to  . 

After entering the Grid Increments, 

click in the model space to update 

the grid display 
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Use the coordinate information in the lower right of the Wall Panel Editor to select the opening 

coordinates. 

 First click on the top left of the opening (4,11). 

 

 

 Next click the lower right corner of the opening (10,8). 

 

  

Wall Panel Coordinates 
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When complete, the opening will show with the X lined and the lintel label. 

 

 Right-click or click ESC to cancel the opening drawing tool. 

 

Wall Panel Design Regions 

When finished, you can add in the design regions around the openings. The Wall Panel Editor allows 

you to create design regions in two ways: manually draw in each region, or by using the automated 

generation tool.  You will use the automated generation for this model. 

 Click on the Generate Wall Regions Automatically button  (in the upper left corner of the 

Editor). 

Turn the rendered view back on for a better view. 

 Click the Toggle Rendered View button  at the top center of the Editor Drawing toolbar. 

Now you can see the opening and four regions that were generated around it. 

 

For more details on how to model wall panels, including information on masonry design and wood 

design, refer to https://www.risa.com/documentation.html. 

 Click OK to close the Wall Panel Editor. 
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This is the end of Tutorial B1.  

If you are using the Demonstration version of the program, you will not be able to save this model, as 

it exceeds the Demonstration version limits.  Please proceed to the next tutorial for instructions on 

how to open the Tutorial B2 Starter File provided by RISA. 

If you are using the full version of the program, you may save by doing the following: On the File 

menu, click Save As and enter a file name. 
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Part B: Tutorial 2 – Slab & Design Strips 
This tutorial will guide you through the drawing and editing the slab edge, support lines, and design 

strips.  This tutorial continues from where the previous tutorial ended, so follow these steps to open 

the Tutorial B2 Starter File provided by RISA: 

 Double-click on the RISAFloor icon to start the program.  

 Click Open Model . Double-click the Tutorials folder, select Tutorial B2 Starter.rfl and click 

Open. Click Close (or Cancel) to exit the Model Settings dialog box.  

 On the Window toolbar, click the Graphic Editing button  to activate the Drawing toolbar. 

Re-Import the DXF Drawing Grid 

 Click on the Modify Drawing Grid button  to re-open the Drawing Grid dialog.   

 Click on the Import DXF tab.  Click to access the recently used DXF file then click Done. 
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Draw the Slab 

Start by drawing in the slab. 

 On the Drawing toolbar, click Create Slab Perimeter  to open the Draw Slabs dialog box. 

In this dialog box, select an existing slab definition or create a new one. For this tutorial, we will define 

a new slab. 

Note:  If you are using the Demonstration version, this option is not available, so you will need to skip 

down to the Draw Slab section on page 137 to accept the default slab definition and continue drawing. 

 

 

Slab Definition 

 If you are not using the Demonstration version, click on the New button. 
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 Type in the label “Tutorial Slab”, change the Thickness to 8”, and set the Diaphragm type to 

Semi-Rigid. 

 

 Click OK to exit the dialog and return to the Draw Slabs dialog.  

The new slab definition should now be selected in the dialog.   
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Draw Slab 

 Click Apply to start drawing. 

Note: The cursor will change to  to signify that you are now in drawing mode. 

Draw your Slab edge: 

 Using the snap points from our DXF drawing grid background to draw in the edge of the slab. 

 

When you click back on the starting point a second time to finish, the tool will release and your slab 

edge will turn green as shown above. 

 Right-click your mouse once more to cancel the drawing tool. 

  

Draw in the slab by 

clicking around the 

edge at the corner 

points. 

Notice that the slab 

edge is anchored as 

you select your points. 

 

Note: the slab edge 

can be any polygon 

shape.   

The curved edge has 

snap selection points 

about every three 

feet.  If you hover 

your cursor over the 

edge you will see a 

red snap point star 

appear where a 

selection point can 

be clicked. 
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When finished, your model should look like the following. 

 

If you have made any mistakes, you can use the Redraw Edges tool to correct the slab edge rather 

than having to re-draw it completely.  To access this tool, click on the Draw Slabs button  from the 

Drawing toolbar and click on the Modify Slabs tab.  Under Modify Slabs, select Redraw Edges.  Click 

the Use? checkbox and then Apply.  Now you can click on a slab edge and redraw just that edge of the 

slab. 

 

For more direction on how to use this tool, please see the Redraw Edges section below on page 143. 
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Modifying Your Slab 

There are a number of ways in which you can modify your slab.  We will start by editing the slab 

properties through the Slab Definitions spreadsheet. 

 Click on Slab Definitions from the Data Entry toolbar. (If the Data Entry toolbar is not visible, 

click the Data Entry button  on the RISA toolbar). 

Here you can see your slab properties in spreadsheet form. 

 Click on the Loads tab. 

 Change the Const LL to 0.02 ksf for the Tutorial Slab on line 3. 

 

 Close the spreadsheet by clicking on the Close button . 

Next, you will modify the slab edges. 

Offset Slabs 

The first slab edge modification tool allows us to offset the slab edge overhang distance in one quick 

click. 

 Click on the Modify Slab Edge button  from the Drawing toolbar. 

 Enter an Offset Distance of 2 feet and select Apply Entries to All Selected Slab Edges. 

Note: You can enter a negative value into the Offset Distance entry if you need to pull back your slab. 

 

 Click Apply. 
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Once you click Apply, the entire slab edge will pop out by two feet.  If you still have your DXF drawing 

grid in the background, you can clearly see the difference. 

 

 Click Undo  once to return to the original slab edge. 

  

Offset Slab Edge 

Original Slab Edge 
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Modifying the Slab Edges  

If you need to move a single side of your slab edge, or change them one at a time, you can use the 

Modify Slab Edges tool.  We will test out a few of these options. 

 Click on the Create Slabs button  from the Drawing toolbar. 

 Click on the Modify Slabs tab. 

This feature allows you to select several points along a slab edge and “merge” them together onto one 

straight line.  This is best understood by seeing it work, so you will test it out next. 

 Under Modify Slab Edges, select the Merge Points option. 

 Under Merge Points, select Click/Box Slab Points. 

 Select the Use? checkbox. 

 Be sure to select the Keep this dialog open checkbox and then click Apply. 

 

You may need to move the Modify Slabs dialog out of the way while working.  You can simply “grab” it 

and move it by clicking on the title bar and holding your left mouse button. 

Note: Your cursor in the graphical model view will now look like this  in order to designate that you 

are in modification mode. 
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 Box select the lower right side of the slab edge as shown here: 

 

When you let go of your cursor, you will see the edge of the slab pops in and all the points align in a 

straight line: 

 

 Click ESC on your keyboard or right-click your mouse to escape the modification tool. 

 Click Undo  once to return to our original slab edge. 
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Your model should look like this again: 

 

Next, test out the Redraw Edges option. 

 Return to your Modify Slabs dialog, which should still be open.  If not, press CTRL+D to reopen 

the last dialog. 

 Under Modify Slab Edges, select Redraw Edges. 

 Uncheck the Keep this dialog open checkbox. 

 

 Click Apply. 
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Once you click Apply, this instructional dialog will open: 

 

 Click OK to continue. 

Note: Your cursor in the graphical model view will now look like this   in order to designate that 

you are in modification mode. 

 Click first on the upper edge of the slab and then click on the point to re-draw the edge. 

          

  

First Click Second Click 
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When finished, your slab edge will look like this: 

 

Undo this step to return to the original slab: 

 Right-click your mouse to cancel the modification tool. 

 Click Undo  once to return to our original slab edge. 
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Creating a Slab Opening 

Next, you will add an opening to the slab floor. 

 Click on the Create Slab Opening button  from the Drawing toolbar. 

 Select Polygon: Point to Point Draw the Opening. 

 

 Click Apply. 

Note: Your cursor will change to  in order to designate that you are now in drawing mode. 

Since the opening is not on the DXF drawing grid background, turn on the Universal Snap Points to 

help you draw in the opening. 

 Click on the Universal Snap Points button  from the Drawing toolbar. 
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Draw in the opening: 

 Using the cursor coordinate information on the right-hand side of the Status Bar, draw in the 

opening by clicking on the following points: 

(32,20,0) 

(42,20,0) 

(43,12,0) 

(31,12,0) 

Once again on (32,20,0) 

 

Once you have drawn in the opening, be sure to turn off the Universal Snap Points and the Drawing 

Grid. 

 Unselect the Universal Snap Points button  from the Drawing toolbar. 

 Unselect the Drawing Grid button  from the Drawing toolbar. 

  

Note: 

You can draw an 

opening polygon 

of any shape. 

Zoom in on the 

lower portion of 

the model for an 

easier view. 
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Next, you will draw in the elevator shaft opening. 

 Click CTRL+D to re-open the Create Slab Openings dialog box. 

 Select Rectangular Opening and Draw by Clicking Points. 

 

 Click Apply. 

To draw in the rectangular opening, you only need to select two opposite corner points.  

 First, zoom in on the upper portion of the model. 

 Click on the upper left corner of the elevator walls. 

 Pull the opening rectangle down to the lower right corner and click on the wall-beam 

intersection at this location. 

    

 

 Right-click to release the opening tool.  

First Click 

Second Click 
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When complete, the model will look like the following image. 
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Support Lines and Design Strips 

Design strips are used to create design regions within a slab.  Each design strip will contain 

automatically defined design cuts which will control the reinforcement design for that design strip.  

The results for the entire design strip will be determined by the maximum moment demand of the 

governing design cut within that design strip.  Because one governing design cut controls the entire 

design strip, it is critical that good engineering judgement is used to determine an appropriate width 

for the design strip. 

You define design strips with the use of support lines, and you can either manually enter a fixed width 

for each design strip, or have the program automatically generate strips based off of your support line 

locations. In this tutorial you will use the automated generation and then modify the design strips as 

necessary. 

 Click on the Support Lines button  on the left side of your screen. 

 Under Strip Width, select Automatic. 

 Under Strip Orientation, select North-South. 

 

 Click Apply. 

Note: Your cursor will change to  in order to designate that you are now in drawing mode. 
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 Draw in your support lines by clicking column to column. Note that you can click over existing 

columns and the support line will break at the column as long as it’s collinear with your line.   

Start by clicking on the red lateral column in the lower left corner. 

            

 Continue to draw in all the Support Lines as shown below. 

 

Before drawing the East-West Support Lines, toggle off the view of the North-South Lines for a simpler 

view. 

 On the Window toolbar, click on the black arrow next to the Design Strip button  (upper 

right corner). 

 Select E-W Support Line.   

The North-South Lines will be toggled off. 

  

First Click Second Click 

Note: After you draw a 

support line, your cursor is 

“anchored” to the last 

column you clicked on. To 

release the drawing tool, 

use your right mouse 

(right-click) or ESC. 
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 Return to the Draw Support Line dialog by clicking CTRL+D. 

 Change the Strip Orientation to East-West and the Design Rule to E-W Rebar. 

 

 Click Apply. 

 Draw in all the Support Lines as shown below. 

 

Note: There is no 

need to draw 

support lines over 

the lateral beams. 
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Toggle back on the display of all Support Lines. 

 On the Window toolbar, click on the black arrow next to the Design Strip button . 

 Select All.   

 

Note: The Support Line labels may vary depending on the order in which they were input, so it is okay 

if your lines do not exactly match those shown above. 
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Since there are some significant cantilevered portions of the slab floor, you will next extend some of 

the Support Lines out to the edge of slab. 

 Return to the Draw Support Line dialog by clicking CTRL+D. 

 Click on the Modify Area tab. 

 Select Extend Support Line. 

 

 Click Apply. 
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To extend a Support Line, you just click on the end of the Support Line that you want extended, and 

then select the edge location that you want to extend it out to.  You will do this next. 

 First click on the left side of the E-W (horizontal) Support Line near the curved cantilevered 

portion of the slab. 

 Next, click on the edge of the slab.   

    

 

 

 Repeat for the other E-W Support Line that extends over the curved cantilevered portion of 

the slab. 

  

First Click Second Click 
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Generate Design Strips 

Now that you have laid out Support Lines between your columns and walls, you will use the 

automated Design Strip Generator to quickly define your design strips. 

 Click on the Generate Strips button  on the left side of your screen. 

Note: if you had used the Fixed Support Line width option, you would not need this step. 

You should now see the automated Design Strips displayed in orange: 

 

As seen above, there are some locations where the auto-generated Strips are overlapping or askew, 

therefore you will use the Modify tool to manually adjust their edges.   

  

Note: Your design 

strips may look slightly 

different depending on 

how the support lines 

were drawn. 



  Part B: Tutorial 2 – Slab & Design Strips 

157 

 

To make this easier to see, select just one set of Design Strips to view at a time. 

 Click on the black arrow next to the Design Strips button  on the Window toolbar. 

 Select E-W Design Strip and you will now see just the E-W Support Lines and Design Strips 

displayed. 

 

You will now manually edit the Design Strip edges. 

 Click on the Support Line button . 

 Click on the Modify Area tab. 
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Redraw Edges  

The first option within this dialog is the Redraw Edges option.  Using this will allow you to select the 

edge of one of the automatically generated Design Strips and redraw it. 

 Select Redraw Edges. 

 

 Click Apply. 

 Zoom in on the bottom of the building, as shown below. 
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 First click on the Design Strip edge and then select the new location to “pull” the edge line out 

to: 

  

 

When finished the Design Strip edge will turn purple to indicate that this design strip was manually 

modified. 

 

Note: As shown in the example above, it is okay to extend your design strip over the edge of your slab. 

Only the portion within the slab edge will be considered for design. 

  

First Click Second Click 

The purple edge 

indicates that the 

edge has been 

modified. 
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Edge Align Tool 

Next, you will use the Edge Align Tool to modify some of the other Strips.  This tool will allow you to 

redefine a Design Strip edge by simply snapping it to a nearby line. 

 Return to the Modify Area dialog by clicking CTRL+D. 

 Select the Edge Align Tool. 

 

 Click Apply. 

 This time zoom in on the upper edge of the model, as shown below: 
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 First click on the Design Strip edge and then the line that you want to align with. 

 

Note: Notice that after your first click, the selected edge highlights in green to show what is selected. 

When finished your model should look like this: 

 

Delete Items 

You will not use this in the tutorial.  However, should you ever need to delete a support line or a 

design strip you can use this tool to do so. 

Note:  To go through the modifications for each Design Strip may be a little time consuming.  Feel free 

to go through them yourself (remember to do both the North-South and the East-West strips) or if you 

would like to save time, you can jump ahead to the Tutorial B3 Starter.rfl starter file in which these 

have been done for you. 

  

First Click Second Click 

The purple edge 

indicates that 

the edge has 

been modified. 



Part B: Tutorial 2 – Slab & Design Strips 

162 

 

Design Cuts 

Design Cuts may be used to examine an area of interest and may also be used to double check Design 

Strip results. While Design Strips automatically contain Design Cuts, you may also draw Design Cuts 

individually. 

Before drawing the Design Cut, turn off the display of the Design Strips. 

 Click on the black arrow next to the Design Strips button  on the Window toolbar. 

 Select None.  

Draw a design cut near the opening to investigate that particular area of interest. 

 On the Selection toolbar, click Design Cut . Your cursor will change to the saw tool  .  

 Click on the Universal Snap Points button  from the Drawing toolbar to help draw.  It will 

show as indented in when turned on. 

 Draw in a Design Cut near the opening (the exact location does not matter). 

Notice a green line appears showing the location of the design cut (you may have to zoom in to see it). 

 

 

Note: If you skipped ahead to the Tutorial B3 Starter.rfl starter file, this step was already completed 

for you. 

 

This is the end of Tutorial B2. 

If you are using the Demonstration version of the program, you will not be able to save this model, as 

it exceeds the Demonstration version limits.  Please proceed to the next tutorial for instructions on 

how to open the Tutorial B3 Starter File provided by RISA. 

If you are using the full version of the program, you may save by doing the following:  On the File 

menu, click Save As and enter a file name.   
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Part B: Tutorial 3 – Loading 
This tutorial will guide you through adding and editing the various types of loads available in RISAFloor 

ES. 

This tutorial continues from where the previous tutorial ended, so follow these steps to open the 

Tutorial B3 Starter File provided by RISA: 

 Double-click on the RISAFloor icon to start the program.  

 Click Open Model . Double-click the Tutorials folder, select Tutorial B3 Starter.rfl and click 

Open. Click Close (or Cancel) to exit the Model Settings dialog box.  

 On the Window toolbar, click the Graphic Editing button  to activate the Drawing toolbar. 

 Turn off the view of the Design Strips by clicking on the Design Strip button  on the 

Drawing toolbar.  Click on the black menu arrow and select None. 

Your screen should now look like this: 
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Area Loads 

Area load magnitudes are defined in a spreadsheet and then applied to the floor as polygons. Area 

loads that are within the slab edges (but not inside an opening) are automatically attributed to the 

supporting elements based on the load Direction set in the Slab Definition. 

Edit the Area Loads spreadsheet, as shown below: 

 On the Data Entry toolbar, click Area Load Definitions. 

 Edit the load information to match what is shown in the image below: 

 

The entries in the Area Loads spreadsheet are described below: 

Label The name you will later use to refer to the load when you apply or view it. 

Additive If this is checked, the load applied will add to the load that is drawn beneath it in 

the order of how they were drawn in the model. 

PreDL 

PostDL 

LL 

LL Type 

These entries allow you to specify load magnitudes for different categories that 

will later be used in the load combinations that you solve.  

 PreDL and PostDL are for dead loads that are pre- and post-composite. 

Remember that other dead loads (deck self-weight and construction 

dead load) were already defined within the deck definitions spreadsheet.  

 LL and LL Type load columns are for the live load magnitude and the type 

of live load which you may choose from a list. 

VL 

 

Specifies the vibration load. The vibration load (along with the self-weight of the 

beam and deck) will be used for calculating the mass for a vibration check, per 

AISC Design Guide #11.  

Dyn Load The dynamic load will be used to determine the diaphragm mass and mass 

moment of inertia for a RISA-3D seismic analysis. 

Each floor has a default area load that will be used within the entire floor slab if no other load is 

specified. On the Data Entry toolbar, click on Floors to see what defaults are applied to each floor. To 

use different loads in an area, you can graphically draw on local area loads.  

 Click Close  to exit the spreadsheet and return to the model view. 
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Drawing Area Loads 

 To apply local area loads:  

 On the Drawing toolbar, click the Area Loads button . 

 Under Uniform Area Loads, in the Area Load box, select Storage, then select the Point to Point 

Draw of the Area drawing option. 

 

 Click Apply.  

Note: The cursor will change to . 

Before drawing, turn on the Universal Snap Points. 

 Click the Universal Snap Points button  from the Drawing toolbar. 

Notice you also have the option 

of drawing in a tapered load.  This 

can be useful for modeling certain 

types of snow loads but will not 

be used in this tutorial. For more 

information on tapered area 

loads please refer to the 

RISAFloor General Reference. 
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 Draw the polygons for the area load by clicking on the drawing grid snap points, as shown in 

the following figure.  

 

 Click on Area Loads button  to reopen the Create Area Loads dialog box. 

 Under Uniform Area Loads, in the Area Load box, select Public. 

  

 Click Apply. 

Storage Area Load 

Corner Coordinates: 

(42,104,0) 

(42,117,0) 

(5,117,0) 

(5,104,0) 

 



 Part B: Tutorial 3 – Loading 

167 

 

 Draw in the Public area load by clicking on the drawing grid snap points, as shown in the 

following figure. 

 

 Press CTRL+D to reopen the Create Area Loads dialog box. 

 Under Uniform Area Loads, in the Area Load box, select Add Piping. 

  

 Click Apply. 

Public Area Load 

Corner Coordinates: 

(5,5,0) 

(50,5,0) 

(50,41,0) 

(5,41,0) 
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 Draw in a Piping load by clicking on the drawing grid snap points, as shown in the following 

figure. 

 

Note: In areas where more than one load is applied on top of another, the top load (the last one 

drawn) will be used by RISAFloor ES. The exception to this is that any additive load will be applied 

along with the load beneath it.  

 Right-click to release the drawing tool.  

Piping Area Load 

Corner Coordinates: 

(17,2,0) 

(17,117,0) 

(23,117,0) 

(23,2,0) 
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Plotting Area Loads 

RISAFloor ES gives you two ways to plot the area loads. The first is to view them as they were input. 

The second is to view them as they are resolved and applied by RISAFloor ES. You are going to view 

them “as applied” for this model. 

To plot the area loads:  

 On the Window toolbar click the black arrow next to the Area Loads button .  

 Select the As Applied. 

 Select the DL PostComp category display from the Load Display option . 

Your screen should look similar to the figure shown below: 

 

Notice that the default Office load was applied automatically. Also, note that the additive piping load 

was automatically combined with the Office, Public, and Storage loads that it crossed.  
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Toggle Load Display 

On the Window toolbar, you can use these three controls to manipulate the display of your loads:  

 

Use these buttons to change the display of loads. 

 Click the Switch Load Display button  on the Window toolbar to change from load 

category display to load combination display.  

 Use the Load menu to select LC 4: Strength Dead + Live. 

 

You will see the “As Applied” load magnitudes change to reflect the selected load combination.  Scroll 

through the other load display options.  When finished, turn off the display of the area loads, as 

follows: 

 On the Window toolbar click the black arrow next to the Area Loads button .  

 Select the None. 

Toggle the graphical 

display of the loads. 

Select the various load 

categories or combinations. 

Toggle between load 

categories and combinations. 
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Line Loads 

You can use line loads to model the weight of cladding, partitions, architectural components, etc. 

Prepare to draw in line loads as follows: 

 On the Drawing toolbar, select the Line Loads button . 

 Enter the information as it appears in the following figure:  

  

 Click Apply. 

Note: The cursor will change to to designate that you are now in drawing mode. 
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To see the model better while you are drawing in the load, change to an isometric view and zoom in: 

 On the Window toolbar, click on the Isometric button . 

 Click the Zoom buttons to zoom in on the right-hand portion of the floor as shown in the next 

image.  

 Draw in the load by clicking on the two points, as shown in the image below (left to right). 

When finished, right-click to release the mouse.  

 

When you are finished, notice that you have specified a tapered line load to represent a non-structural 

partition. The line load spans diagonally across the slab.  

To return to a planar view and continue: 

 Use the right mouse button (right-click) or press ESC to exit the drawing mode. 

 On the Window toolbar, click the Plan button . 

 On the Window toolbar, click Redraw  to return to a full view. 
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Point Loads 

Prepare to apply point loads: 

 On the Drawing toolbar, click Assign point loads . 

 Enter the information show below:  

  

 Click Apply. 

Note: The cursor will change to  to designate that you are now in drawing mode. 

Toggle on the Universal Snap Points to help you draw the point loads. 

 Make sure the Universal Snap Points button  on the Drawing toolbar is turned on (the 

button will be depressed). 
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 Zoom in significantly on the triangular portion of the floor using the mouse roller, as shown 

below.  

 

Draw in the point loads: 

 Use the coordinates (notice they are displayed in the Status bar) and the snap points to draw 

in a point load at each of the following coordinates: 

(61,86,0) 

(61,76,0)  

(56,81,0)  

(66,81,0)  

 

When you are finished, your screen should look like this:  

 

Note: Point loads that are applied inside the deck edges may be applied anywhere on the deck and will 

be attributed automatically to the beams, walls, and columns.  

 Right-click to release the drawing tool. 
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The last modification step is to create a second floor.   

 To create a new floor level, click the New Floor button  from the RISA toolbar. 

 Under Floor Type, select Concrete Floor Slab. 

 Under Floor Creation Options, select Copy of Floor Plan 1. 

 Enter an Elevation of 30 feet. 

  

Note:  Notice that you also have the option in this dialog to add a new Beam Supported Floor.  It is 

possible to have different floor types within one model. 

 Click Ok. 

This will open a second model view window that shows the new second floor. Return to the default 

view. 

 From the Window menu, select Single View. 
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Next, view the full isometric model view. 

 Click on the Floors menu on the Window toolbar and select Full Model.   

 

This will show the full model (both floors) in a rendered isometric view.  

 

Note:  Notice that the opening in the elevator shaft wall created in the first floor was not copied into 

the second floor. Wall openings must be created individually. 

This is the end of Tutorial B3. 

If you are using the Demonstration version of the program, you will not be able to save this model, as 

it exceeds the Demonstration version limits.  Please proceed to the next tutorial for instructions on 

how to open the Tutorial B4 Starter File provided by RISA. 

If you are using the full version of the program, you may save by doing the following:  On the File 

menu, click Save As and enter a file name.
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Part B: Tutorial 4 – Solution & Results 
This tutorial will guide you through generating load combinations, running a solution, design 

optimization, and reviewing the results. 

This tutorial continues from where the previous tutorial ended, so follow these steps to open the 

Tutorial B4 Starter File provided by RISA: 

 Double-click on the RISAFloor icon to start the program.  

 Click Open Model . Double-click the Tutorials folder, select Tutorial B4 Starter.rfl and click 

Open. Click Close (or Cancel) to exit the Model Settings dialog box.  

 On the Window toolbar, click the Graphic Editing button  to activate the Drawing toolbar. 

 Turn off the view of the Design Strips by clicking on the Design Strip button  on the 

Drawing toolbar.  Click on the black menu arrow and select None. 

Your screen should now look like this:  
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Load Combinations 

RISAFloor ES solves load combinations that are defined in the Load Combinations spreadsheet. As 

RISAFloor ES designs members, it chooses members that satisfy the codes specified in the Model 

Settings and the rules that are defined in the Design Rules spreadsheets.  

To view the load combinations: 

 On the Data Entry toolbar, select Load Combinations. 

 

On the Combinations tab, you will combine and factor the various load categories that you have 

already applied to your model.  

 Press the F4 key four times to delete the default load combinations. 

Load Combination Generator 

Now that you have a spreadsheet open, notice the Window toolbar looks different. 

 

 On the Window toolbar, click the LC Generator button.  The Load Combination Generator 

dialog box will be used to generate the load combinations needed to design the model. 

For this tutorial, assume that in the regions where this project will be built, the governing roof loads 

are usually roof live load, rather than snow or rain.  

 In the LC Region list, select United States.  

 In the LC Code list, select 2015 IBC ASD. 

 Click to clear the SL and RL check boxes so that you will not be generating more load 

combinations than are needed. 

  

 Click Generate. 
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The following load combinations will be generated by RISAFloor:  

 

 Click the Design tab to review the remaining information associated with these pre-generated 

load combinations. 

 

On this tab you can specify which load combination can be applied to a specified material. The Service 

checkbox can also be used to designate which combinations will be used for Slab Point Deflection 

results (on concrete slab floors only).   

Finish by generating strength level combinations. 

 Click the LC Generator button .  

 In the LC Code list, select 2015 IBC Strength. 

  

 Click Generate. 
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This finalizes your load combinations as shown below:  

 

Notice you have total control of the design of all member types using the check boxes. If you had any 

wood members in your model, they would only be designed for the ASD load combinations. 

Solving the Model 

To solve the model: 

 On the Main menu, click Solve – Design Members/Walls/Slabs. 

The first solution results in a Solution Warning. 

  

This Warning comes up because the program performs a solution for the upper floor first.  When the 

model is solved “top-down” it is common for the original “required” size of a column at the upper level 

to be insufficient at the lower level. This dialog allows you to update the upper level column sizes and 

solve again. 

 Click RESOLVE to replace the upper columns and resolve with the larger sizes.  

The Solution Warning will come up a second time.  This time just accept the current column sizes so 

you can move on and review your results. 

 Click OK when the next Solution Warning dialog comes up.  
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When the solution is finished, the chosen member sizes are displayed on the plot (or, if you are in 

rendered mode, the model is rendered with the sizes) and the solution Warning Log is displayed.  

 

The purpose of the Warning Log is to inform you whenever a modeling issue or error arises which 

affects the design of the floor. For example, in the image above, you are being warned that the 

punching shear checks do not consider slab openings.  This is a program limitation, not an input error. 

Note: Results produced by your model may not exactly match the results shown in this tutorial. This 

may be caused by a variety of factors, including how the model was created and which version of the 

program is being used.  

 

Reviewing the Results 

After the solution, the Results toolbar automatically opens on the right side of the screen.   

The Results toolbar should now open on the upper right of your model space on top of the Data Entry 

toolbar.   
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Take a look at some of the results. 

 From the Results toolbar, click on Column Results. 

 Select the Concrete tab. 

 From the Results toolbar, click on Punching Shear. 

 

Notice that there are several failures where the punching shear UC exceeds 1.0.  These are displayed 

in red text.  The Punching Shear spreadsheet reports the governing load combination (LC) as well as 

the values that came up with the failure. For more information you can also see the Detail Report. 

These failures are most likely due to the slab only being eight inches thick. Therefore, you can thicken 

up the section of slab around the columns with shear caps. 

Editing the Model 

Add on a couple shear caps to investigate how to correct a failing model.  From the Punching Shear 

spreadsheet above, you know columns CS1 and CS3 are failing on the first floor level.  You will add 

shear caps to these columns. 

 Close all open spreadsheets. 

 Click on the Floors menu on the Window toolbar and select 1: Floor Plan 1(Slab) 

 From the Modify menu, select Columns. 

 Click Yes to close the Clear Results Warning. 
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Use the Modify Column Properties dialog to add in a shear cap. 

 Under Shear Cap Options, select the Use? checkbox. 

 Select Add/Modify Rectangular Shear Cap (in). 

 Enter a Thickness of 18”, a Depth of 60” and a Width of 60”. 

 Select Apply Entries by Clicking/Boxing Columns Individually 

  

 Click Apply. 

Note: Your cursor will change to  to designate that you are in modification mode.  
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To find the location of the columns, turn on the column labels. 

 From the Window toolbar, click on the Model Display Options button  to open the Set 

Options for Current View dialog. 

 Click on the Beams/Columns/Walls tab. 

 Under Show Columns, set the Labeling option to Label. 

  

 Click OK and you can see that columns CS1 and CS3 are in the upper left corner of the first 

floor. 

Now add a Shear Cap to these columns. 

 Click on the two columns with your drawing tool cursor. 

 

 Right-click or click ESC to escape the modification tool. 
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When complete, the model should show the shear cap perimeters. 

 

Now that you have made the modification to the model, solve again. 

 Solve the model by clicking on the Solve button  from the RISA toolbar. 

 Click OK from the Solution Warning. 

 Close all open spreadsheets by clicking on the Close button . 

Now you can take a look at the rest of the results.    

Spreadsheet Results 

Open the Strip Reinforcing spreadsheet:  

 On the Results toolbar, select Slab Results/Rebar. 

 

The Strip Reinforcing spreadsheet summarizes all design strip and cut results. The Design Strip Results 

tab lists a summary of the reinforcement design, including the UC Top (code check value at top), UC 

Bot (code check at the bottom), and the UC Shear (shear code check). Similar information can be 

found under the Design Cut Results tab. 
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You may open the other spreadsheets to review the other types of results. 

 From the Results toolbar select Column Forces, Slab Strip Deflection, etc. 

 

Return to your model view: 

 On the Main menu, click Window and select Single View. 
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Viewing Graphical Results 

Explore the graphic result viewing options: 

 On the Main menu, click View, and select Model Display Options. 

The Set Options for Current View (i.e. Model Display Options) dialog contains all the options for 

graphic display in your model.  This includes input and results information.  If you have not solved your 

model, the results options will be unavailable.  

Turn on color coding contours of the displacements from Load Combination 2. 

 Click the Slabs tab. Under Show Slabs As, select Color Fill.  

 Under Color Basis, select Contours.  Then, under the Contouring Control section, set the 

Value to Displacement.  

 Set the Combination To Use for Results Display to LC2: IBC 16-9 Pre. 

  

 Click Apply.  
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Your plot should now look like this:  

 

This image gives a quick graphical representation of the displacements per Load Combination 2. The 

color-coding legend is displayed in the upper right corner (you may need to move your Results or Data 

Entry toolbars to see this). You can create a similar plot to display the Bending or Shear forces.  

 Click Cancel to exit the dialog box and return to your model view. 
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Next, take a look at the design strip graphical results but this time you will use the Window toolbar 

buttons.  These give you quicker access to the graphical plot options. 

 Click on the black arrow next to the Design Strip Diagram button  from the Window 

toolbar. 

 Select Out of Plane Shear. 

Your model view should now look like this: 
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Detail Reports 

Take a look at the details of the design for the Support Lines and Design Strips. 

 On the Selection toolbar (left side), click the Detail button . 

Note: Your cursor will change to . 

 Click on any of the Support Lines to review the additional information in the Strip Detail 

Report. 

 

The Detail Report displays enveloped shear and moment diagrams for each span of the Support Line. 

It also gives Analysis Results (Max and Min Shear and Moment values used for reinforcement design) 

and Deflection Results for each span.  
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You can use the drop-down menu in the upper left to see the Total report or the more detailed reports 

for the Column Strip, Mid-Strip Right, or Mid-Strip Left.  

 Select Column Strip from the drop-down menu on the upper left. 

 

 Scroll down to the bottom of the detail report and you can review the Rebar Details, Analysis 

Results, Code Checks, and Deflection Results. 

 

Next, you will take a look at the governing Cut results. 
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The reinforcement for each Design Strip is governed by an internal Design Cut.   

 Click on the Cut button  from the Design Strip Detail Report. 

This will open the Design Cut Detail Report for the governing cut for Column Strip Span 1. 

 

The Design Cut Detail Report shows the detailed information and values that governed the design of 

each Cut within the Design Strip.     

Note: You can click on the forward and backward arrows  at the top left to scroll quickly 

through the Design Cut Detail Reports. 
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You can also review the design results for the single Design Cut drawn in by the opening. 

 First, click Close  to close the Detail Report and return to the model view. 

Turn off the display of the support lines. 

 Click on the black arrow next to the Design Strip Diagram button  from the Window 

toolbar. 

 Select None. 

Now, take a look at the Design Cut Results: 

 With your Detail tool cursor still active, zoom in next to the opening and click on the green 

Design Cut that you drew on in Tutorial B2. 

 

This will open the Detail Report for the single Design Cut. 

 

When finished reviewing these results, close the Detail Report. 

 Click Close  to close the Detail Report and return to the model view. 
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Now you can review the column design results in the Detail Report. 

 With your Detail cursor  still active, click on the top left column (with the shear cap). 
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This will open the Envelope Column Detail Report. 

 

 Scroll down through the report to review the enveloped force diagrams, Code Check, 

Interaction Diagrams, and reinforcement design details. 

Next, take a look at the Punching Shear results. 

 From the drop-down menu in the upper left, select Punching Shear. 
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This will open the Punching Shear Detail Report for the column which now shows the passing code 

check. 

 

 Scroll down through the report to review detail views, Check Results, and Punching Shear 

Geometries. 

 When finished, close the Detail Report by clicking on the Close button . 

 

 

 

 

 

This is the end of Tutorial B4. 

If you are using the Demonstration version of the program, you will not be able to save this model, as 

it exceeds the Demonstration version limits.  Please proceed to the next tutorial for instructions on 

how to open the Tutorial B5 Starter File provided by RISA. 

If you are using the full version of the program, you may save by doing the following:  On the File 

menu, click Save As and enter a file name.
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Part B: Tutorial 5 – RISA-3D Integration 
This tutorial is intended to introduce you to the features of RISA-3D that directly relate to its 

interaction with RISAFloor ES. For more detailed information on RISA-3D, refer to the RISA-3D User’s 

Guide and RISA-3D General Reference.  

This tutorial continues from where the previous tutorial ended, so follow these steps to open the 

Tutorial B5 Starter File provided by RISA: 

 Double-click on the RISAFloor icon to start the program.  

 Click Open Model . Double-click the Tutorials folder, select Tutorial B5 Starter.rfl and click 

Open. Click Close (or Cancel) to exit the Model Settings dialog box.  

 On the Window toolbar, click the Graphic Editing toolbar button  to activate the Drawing 

toolbar. 

 Turn off the view of the design strips by clicking on the Design Strip button  on the 

Drawing toolbar.  Click on the black menu arrow and select None. 

Your screen should now look like this: 
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To see the interaction between RISAFloor ES and RISA-3D, solve your RISAFloor ES model, and then use 

RISA-3D to analyze and design your lateral system.  

 On the RISA toolbar, solve the model by clicking Solve . 

 Click OK from the Solution Warning dialog (if you are continuing from a previous solution). 

 On the Main menu, click the Director button (top right) and select RISA-3D. 

 

Lateral Load Generators 

When you select RISA-3D you will be prompted for information on the wind and seismic loads of your 

structure.  

First, the Wind Loads dialog box will display: 

 

Review the information shown in the Wind Loads dialog box. In the future, if you make any changes in 

the Wind Load Parameters area, be sure to click Calc Loads to recalculate. 

Be sure to also check the information generated in the Wind Load Results area. This is a summary of 

the wind loads that have been calculated for you.  

 Click OK to accept the loads. 
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After the Wind Loads dialog box closes, the Seismic Loads dialog box will display: 

 

Review the information shown in the Seismic Loads dialog box. In the future, if you make any changes 

in the Seismic Load Parameters area, be sure to click Calc Loads to recalculate. 

Be sure to also check the information generated in the Seismic Load Results area. This gives the 

equivalent static force distribution and base shear values that have been calculated for you.  

 Click OK to accept the loads. 

 If the Model Settings dialog box displays, close it by clicking OK or Cancel. 
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RISA-3D will now open and show an isometric view of your model. The interface of RISA-3D look 

different from RISAFloor but the buttons work the same way.  

 

Notice that only the beam, columns, and wall panels that were specified as LATERAL members were 

generated in your RISA-3D model. You can always add vertical braces, modify your wall panels, or 

manipulate your model as you wish.   For this tutorial, you will leave the model as it is. 
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RISA-3D Diaphragms 

RISA-3D does not import the slab element, but you will have a rigid diaphragm in the exact shape and 

size of the slab that RISA-3D will use to distribute lateral loads to the columns and walls. 

Before doing any graphical editing, turn on the display of the diaphragms: 

 On the Window toolbar, click the Toggle Diaphragm button  to turn on/off the display of 

the diaphragm edges and openings. 

 

Next, look at the diaphragm information in the Diaphragms spreadsheet: 

 On the Data Entry toolbar (at right), click Diaphragms. 

 

Notice that the diaphragms already contain the diaphragm mass and mass moment of inertia 

information that you would need for a dynamic analysis. In this spreadsheet, you can specify the 

percent of width you want RISA-3D to use to account for the accidental eccentricity in the X or Z 

directions. 

 Click Close  to exit the Diaphragms spreadsheet and return to the model view. 

  



Part B: Tutorial 5 – RISA-3D Integration 

202 

 

RISA-3D Loading 

Next, look at the loading information that was brought over from RISAFloor ES. 

 On the Data Entry toolbar (at right), click Basic Load Cases.  You can now review the load data 

that was generated. 

As you review the data in this spreadsheet, notice that all your Basic Load Cases have been created for 

you, including wind and seismic load cases for each direction.  

 

 When you are finished reviewing the data, click Close  to close the spreadsheet and return 

to your model view. 
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RISA-3D Load Combination Generator 

Next, add the common load combinations used for this type of model, including all the code required 

eccentric loadings for wind and seismic loads. This will demonstrate how the program automatically 

generates these load combinations; saving you the time and energy normally spent entering them 

manually.  

 On the Data Entry toolbar, click on Load Combinations to open the Load Combinations 

spreadsheet. 

Although you previously generated load combinations for your RISAFloor model, you will now 

generate your lateral load combinations separately for use in the RISA-3D model. 

 Click the LC Generator button within the Load Combinations spreadsheet. 

 

 On the first (Gravity) tab, in the LC Region list, select United States. 

 On the first (Gravity) tab, in the LC Code list, select 2015 IBC ASD. 

 Clear the Generate Deflection LCs box. 

 Click Generate. 
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 Click on the Wind tab. 

 Under Wind Load Options, click X and Z w/Ecc (make sure the Reversible check box is 

cleared). 

 

 Click Generate. 

 Click on the Seismic tab. 

 Under Seismic Load Options, click X and Z w/Ecc (make sure the Reversible check box is 

cleared). 

 



  Part B: Tutorial 5 – RISA-3D Integration 

205 

 

 Click Generate.   

Go back and generate the strength level combinations. 

 Click back to the Gravity tab and change the LC Code list to 2015 IBC Strength. 

 

 Click Generate. 

 Click on the Wind tab.  Make sure that the LC Code also updated on this tab. 
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 Click Generate. 

 Click on the Seismic tab. Make sure that the LC Code also updated on this tab. 

 

 Click Generate.  Then click Close to close the dialog. 

 

This will generate  70 load combinations of which 17 are shown below.  

 

Why so many load combinations? Each code load combination that includes an earthquake or wind 

load becomes six load combinations when you include all the possible eccentric cases (if you had 

selected the Reversible option, this would have expanded to 12 cases). 
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The LC Generator feature allows complete control over whether or not to include these more detailed 

load combinations. Load combinations or categories that are not relevant to your region can be 

completely eliminated by modifying the provided .xml spreadsheets.  

For example, if you are in a year-round sunny climate like south Florida, do you really need to check 

your structure for all the combinations that include snow load? Therefore, to remove the snow loads 

from your generated load combinations, locate and modify the spreadsheet. The United States 

spreadsheet is located in C:\users\Documents\RISA\Load Combination (or C:\RISA\Load 

Combinations) and is named United States.xml.  

Note: Before editing the .xml spreadsheet, you may want to copy the original in case you want to 

restore all the settings back to the default.  

 

With the requirements of the AISC 14th Edition Steel Code and the ACI 318-14 Concrete Code, you will 

need to include P-Delta effects in your results. This is not included by default, but you can include it in 

the Load Combinations spreadsheet. 

 Click the heading of the P-Delta column to highlight the whole column. 

 Click CTRL + F to open the Block Fill dialog box. 

 Type “Y” into the dialog box and click Ok. 

 

This will fill in the P-Delta column with Y, representing a “Yes, include P-Delta effects” for all the load 

combinations. 
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As you can see from this tutorial, the interaction between RISAFloor ES and RISA-3D is completely 

seamless. However, this tutorial is only an introduction to the many features of RISA-3D. We 

recommend downloading the RISA-3D User’s Guide for further tutorials on this program’s powerful 

features including solution, results, modifications, etc. 

 

This is the end of Tutorial B5. 

 

Note: If you save the model, you will notice that this file saves as a RISAFloor (.rfl) model, even though 

we have now been working in RISA-3D. This is because the file contains RISAFloor data that would be 

lost if the RISA-3D file were detached. To reopen the file in the future, you will need to open it in 

RISAFloor, solve, and use the Director tool to bring it back into RISA-3D. 
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Part B: Tutorial 6 – DXF Export 
RISAFloor ES offers a DXF import/export feature that provides two-way compatibility with any other 

program that can read and write DXF files--this includes most major CAD programs and many analysis 

programs. With this feature, RISAFloor ES is able to produce CAD-quality drawings that list your beam 

sizes, camber, stud layout, end reactions, etc.  

Follow the steps below to load the RISAFloor ES starter file for this portion of the tutorial: 

 Double-click on the RISAFloor icon to start the program.  

 Click Open Model . Double-click the Tutorials folder, select Tutorial B6 Starter.rfl and click 

Open. Click Close  (or Cancel) to exit the Model Settings dialog box.  

Solve the model and save: 

 Click Solve  to solve the model.  

 On the File menu, click Save As and enter a new file name. Be sure to Save Results. 

Your model should now display design data. 
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DXF Export 

 On the Main menu, click File, click Export, and select DXF File. 

 Enter the file name Tutorial and click Save. The Export DXF File dialog box will display. 

 Enter the information shown below and click OK. 

 

You should be able to open this DXF file with any standard drafting package. The following is an 

example of the information that can be written to the drawing file.  
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DXF Import 

Similarly, you can import a DXF file into RISAFloor ES for analysis.  

 On the RISA toolbar, click on New Model  to start a fresh model. 

 Click Close to exit the Starting a Model dialog box. 

 On the Main menu, click File, click Import, then select DXF File. Select the first floor tutorial 

file you recently exported and saved. It should be named Tutorial FLOOR_1.dxf.  

The Import DXF File dialog box will open. 

 Enter the information shown below: 

 

 Click OK. Your model will import and open a new floor from the imported DXF file. 

 

This is the end of Tutorial 7. 
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Conclusion 

This completes Part B: Elevated Slab Design.  

Congratulations on completing your introductory tour of RISAFloor ES! The time you invested in 

performing these tutorials is time well spent. We are confident that the knowledge gained by taking 

the time to step through these tutorials will increase your productivity and allow you to complete 

future projects more quickly and efficiently. 

If you have any questions or comments, please contact us by phone at (800) 332-7472 or email at 

info@risa.com. 
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Appendix A – RISAFloor Toolbar Button 

Quick Reference  

RISA Toolbar 

 

 

Button Title Label in RISAFoundation Shortcut 

 New Model  

Start a new model 

Start a new model (CTRL+N) 

 Open Model  

Open an existing model 

Reload from disk a 

previous model 

(CTRL + O) 

 Save  

Save current model to disk 

Save the current model 

data to disk 

(CTRL+S) 

 Copy  

Copy to the clipboard 

Copy to the clipboard (Ctrl+C) 

 Print  

Print a report or graphic image 

Print a report or graphic 

image 

(Ctrl+P) 

 Undo  

Undo the last operation 

Undo the last operation (Ctrl+Z) 

 Redo  

Reverse the most recent undo 

operation 

Reverse the most recent 

undo operation 

(Ctrl+Y) 

 (Global) Model Settings  

Set Model Settings 

Set Model Settings  

 Define Units  

Define units to be used 

Define units to be used  

 Shape Database  
Edit or view the shape 

database 

 

 Rebar Layout  

Create and edit a custom rebar 

layout 

Create and edit a 

custom rebar layout 

 

 Project Grid  

Open the Project Grid 

spreadsheet 

Opens the Project Grid 

spreadsheet 

 

 Create New Floor Plan  Create a new floor plan  
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 Delete Floor Plans  Delete existing floor 

plans 

 

 New Model View  

Create a new model view 

Create a new model 

view 

(CTRL + F2) 

 Open Spreadsheets  

Select spreadsheets to open 

Select spreadsheets to 

open 

 

 Refresh  

Refresh all windows with 

current data 

Refresh all open 

windows with the most 

current data 

 

 Load Combinations  

Open the load combinations 

spreadsheet 

Open the Load 

Combinations 

Spreadsheet 

 

 Solve  

Perform the analysis and 

design calculations 

Perform the analysis and 

design calculations 

(F7) 

 Browse Results  

Select results to browse 

Select results to browse  

 Erase Results  

Erase all solution results 

Erase all solution results  

 Data Entry toolbar  

Turn the spreadsheet 

shortcuts menu on or off 

Turn the Spreadsheet 

Shortcuts menu off or 

on 

 

 Results toolbar  

Turn the results shortcuts 

menu on or off 

Turn the Results 

Shortcuts menu off or 

on 

 

 Help  

View help topics 

View Help menu topics (CTRL + F1) 
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Window Toolbar  

…in Model View  

 

 

Button Title Label in RISAFoundation Shortcut 

 Model Display Options  

Display plot options 

Bring up the Model Display 

Options dialog  

F2 

 Floor Menu 

 

Select which floor you want 

to view 

 

 Snapshot  Save an image of the current 

model view for later use in 

the printed report 

 

 Isometric  

Display an isometric view 

Snap to an Isometric View  

 Plan  

Display an XZ planar view 

Snap to an XZ Planar View  

 Rotate buttons 

 

Rotate the view counter-

clockwise about the X axis 

 

  Rotate the view counter-

clockwise about the Y axis 

 

  Rotate the view counter-

clockwise about the Z axis 

 

 3 buttons below are collectively 

called Zoom buttons 

 

  

 Zoom In  Zoom IN (closer view) on the 

model  

PLUS (+) 

 Zoom Out  Zoom OUT (view farther 

away) on the model  

MINUS (-) 

 Box Zoom  Draw a box around the part 

of the model to be zoomed 

 

 Redraw  

Redraw full model view 

Redraw full model view  
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 Graphic Editing  

Activate the Graphic Editing 

(AKA Drawing) toolbar 

Activate the Graphic Editing 

(Drawing) toolbar 

Ctrl+G 

 3 buttons below collectively 

refer to Loads Display  

 

  

 Display Loads  

Toggle display of the loads (LC 

or CAT) 

Toggle display of the loads 

(LC or CAT) 

 

 Loads List – lists the available 

loads 

 

  

 Switch Loads  

Switch loads display 

(combinations or categories) 

Switch loads display 

between combinations and 

categories 

 

 Rendering  

Toggle between wireframe and 

rendering of members 

Toggle between wireframe 

and rendering of members 

 

 Joint Labels  

Joint labels toggle 

Toggle the joint labels  

  Beam Labels  

Beam labels toggle 

Toggle the beam labels  

 Member End Options  

Member end display options 

Member end display options  

 Show Wall Properties  

Wall Panel toggle 

Toggles on the display of 

Wall Panel properties 

 

 Show Deck Assignment  

Show Deck Assignment 

Toggles on the display of the 

deck for beam supported 

floors only 

 

 Show Area Load Types  

Show Area Load 

Toggles on the display of the 

area loads 

 

 Project Grid Display  

Show Project Grid toggle 

Toggles on the display of the 

Project Grid 
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 Distance Tool  
Measures the distance 

between two points 

F5 

 Design Strip Rebar  

Design Strip rebar toggle 

Toggles on the display of the 

Design Strip rebar 

 

 Design Strip   

Design Strip toggle 

Toggles on the display of the 

Design Strips and/or the 

Support Lines 

 

 Design Strip Diagram  

Design Strip force diagram 

toggle 

Toggles on the display of the 

force diagram on the Design 

Strip 

 

 

 

 

 

 

…in Spreadsheet View 

 

 

Button Title Label in RISAFoundation Shortcut 

 New Line  

Insert a new line before 

the current line  

Insert a new line before 

the current line  

F3 

 Delete Line  

Delete the current line  

Delete the current line  F4 

 Repeat Line  

Repeat the current line 

Repeat the current line F8 

 Fill  

Fill the currently marked 

block  

Fill the currently marked 

block  

Ctrl+F 

 Math  

Perform math on the 

currently marked block  

Perform math on the 

currently marked block  

Ctrl+M 

 Mark Lines  

Mark all the lines 

Mark all the lines  
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 Delete Lines  

Delete the currently 

marked lines  

Delete the currently 

marked lines  

Ctrl+D 

 Unmark Lines  

Unmark all the lines 

UnMark all the lines  Ctrl+L 

 Paste  

Paste from the clipboard  

Paste from the clipboard  Ctrl+V 

 Save as Defaults  

Save the current data as 

the default 

Save the current data as 

the default 

 

 Help 

Help on the current 

window  

Help for the current 

window  

SHIFT+F1 
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Drawing Toolbar 

 

 

Button Title Label in RISAFoundation Shortcut 

 Draw or Modify Columns  

Draw or modify columns 

Draw or modify columns  

 Draw or Modify Walls  

Draw or modify walls 

Draw or modify walls  

 Draw or Modify Beams   

Draw or modify beams 

Draw or modify beams  

 Generate Infill Beams  

Generate infill beams 

Generate infill beams 

within bays 

 

 Elevate Points  

Change the elevation of selected 

points 

Change the elevation of 

selected points in the 

model 

 

 Draw Slabs/Diaphragms  

Draw slabs or diaphragms 

Draw or modify slabs or 

diaphragms 

 

 Assign Deck  

Assign deck properties 

Assign deck properties  

 Add Wood Diaphragm Regions  

Add wood diaphragm regions 

Add wood diaphragm 

regions 

 

 Draw Area Loads  

Draw area loads 

Draw area loads  

 Draw Line Loads  

Draw line loads point to point 

Draw line loads point to 

point 

 

 Assign Point Loads  

Draw point loads 

Draw point loads  
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 Project Grid  

Draw Project Grid Lines 

Draw Project Grid Lines  

 Move   
Move selected parts of the 

model 

 

 Copy   
Copy selected parts of the 

model 

 

 Offset Copy  
Copy selected parts of the 

model using an offset 

distance 

 

 Extend  

Extend the member 

Extend the member  

 Trim  

Trim the member 

Trim the member  

 Delete  

Delete parts of the model 

Delete parts of the model  

 Modify Drawing Grid  

Modify the drawing grid and snap 

points 

Modify the drawing grid 

and snap points 

 

 Drawing Grid  

Toggle the drawing grid on or off 

Toggle the drawing grid on 

or off 

 

 Universal Snap Points  

Toggle the universal snap points  

Toggle the universal snap 

points on or off 
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Selection Toolbar 

 

 

 

Button Title Label in RISAFoundation Shortcut 

 Select All  

Select the entire model 

Make the entire model 

selected  

CTRL+A 

 Box Select  

Draw a box around the part to 

be selected 

Draw a box around the 

part of the model to be 

selected 

 

 Polygon Select  

Draw a polygon around the 

part to be selected (double 

click to end) 

Draw a polygon around 

the part to be selected 

(double click to end) 

 

 Line Select  

Draw a line through the beams 

and plates to be selected 

Draw a line through the 

beams and plates to be 

selected 

 

 Unselect All  

Unselect the entire model 

Make the entire model 

UNselected  

Ctrl+U 

 Box Unselect  

Draw a box around the part to 

be unselected 

Draw a box around the 

part of the model to be 

UNselected 

 

 Polygon Unselect  

Draw a polygon around the 

part to be unselected (double 

click to end) 

Draw a polygon around 

the part to be 

UNselected (double click 

to end) 

 

 Line Unselect  

Draw a line through the beams 

and plates to be unselected 

Draw a line through the 

beams and plates to be 

UNselected 

 

 Invert Selected  

Invert the selected areas of 

the model 

Invert the selected state 

of the model  

Ctrl+I 

 Criteria Selection  

Select or unselect  

Select or Unselect based 

on other criteria 

 

 Save/Recall Selection  

Save or recall selections of the 

model 

Save or recall selection 

states for the model 

 

  Lock Unselected   

 

Lock the unselected part 

of the model  

Ctrl+L 


